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I.  GETTING STARTED 
 
A.  Common Terms 
 

1. Electronic Filing: The process of uploading a document from the filer=s 
computer, using the court=s internet-based Case Management/Electronic Case 
Filing System (CM/ECF) to file the document in the Court=s electronic case file.  
The CM/ECF System only accepts documents in Portable Document Format 
(PDF). 

 
2.  Filing User: An individual who has a login and password to file documents 
electronically using the court=s CM/ECF System.  Since an individual can use the 
same login and password to file in any federal appellate court in which the 
individual has registered, the terms Appellate Filer and Appellate ECF Filer are 
also used. 

 
3.  Notice of Docket Activity (NDA): A Notice of Docket Activity (NDA) is a 
notice sent via email that is generated when a docket transaction requires that 
notice be sent to attorneys, case participants, or court personnel.  NDAs can be 
generated when a party or attorney files a document with the clerk=s office or when 
the court enters an order or takes other public action in a case.  If you are a 
CM/ECF participant, your receipt of the NDA is service of that document or 
order, and registration for the CM/ECF system constitutes consent to receive 
service through the NDA.  Generally, an NDA contains a hyperlink back to the 
court=s docket sheet and the document in question.  When parties receive an NDA 
they can click on the document and obtain a Afree look.@ Parties should save the 
document at that point.  In the district court and bankruptcy court systems the NDA 
is called the Notice of Electronic Filing (NEF).  Parties should save the NDAs as 
proof of the filing.  In this regard, please see Fed. R. App. P. 25(c)(1)(D) and 10th 
Cir. R. 25.4 and 31.5.   

 
4.  PACER: APublic Access to Court Electronic Records@ is an automated system 
that allows subscribers to view, print, and download Court docket information and 
documents via the internet.  An NDA generated for a filing will contain a hyperlink 
to the document(s) filed.  The PACER system allows case participants Aone free 
look@ at that document.  The document(s) should be saved or printed when it is first 
opened from the NDA.  Subsequent electronic access to the document, or electronic 
access to the docket through PACER will be billed by the PACER Service Center 
at $0.10/page with a maximum charge of $3.00 per document. Please note that if 
usage does not exceed $15 in a quarter, all fees will be waived.  
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5.  PDF: APortable Document Format@is a file format used for document exchange.  
The advantage of using PDF for documents lies in the fact that the document=s 
format becomes device-independent, resolution-independent, and fixed-layout.  
The document can be viewed as created, regardless of the software that created it, 
because PDF files do not encode information that is specific to the application 
software used to create the document. 

 
WordPerfect versions 9 and higher include the capability to convert text documents 
to PDF by clicking AFile@ on the toolbar, then selecting APublish to PDF.@ 

 
Microsoft Word 2007 and all later versions have the ability to convert documents to 
PDF. Word 2007 requires a plug-in that you can download for free from 
Microsoft's website.  Older versions of Word require a third-party plug-in such as 
Adobe Acrobat. There are also third-party applications that allow you to generate a 
PDF from a saved document, and many of these are free. 

 
Interactive on-line training on converting Word or WordPerfect documents to PDF 
is available at http://pacer.psc.uscourts.gov/ecfcbt/dc/cccnvtpdf/. 

 
There are two types of PDF files.  Whenever possible, native PDF files must be 
used.  In particular, the Court requires that all pleadings be submitted in 
native PDF.  Attachments to pleadings may be submitted in scanned PDF if native 
format is not available.  A maximum of 10 megabytes (regardless of format) may 
be uploaded per PDF file.  

 
a.  Native PDF: Electronically converted PDF documents are created from 
word processing documents (Word, WordPerfect, etc.) using Adobe Acrobat 
or similar software.  Native PDF documents are text searchable and 
generally have a small file size (that is the reason the court requires that all 
pleadings be in native PDF).  Native PDF documents up to 10 megabytes in 
size may be uploaded as a single file; documents exceeding that limit should 
be split into separate files using appropriate identification of the files.  

 
b.  Scanned PDF: Scanned PDF documents are created by putting paper 
documents through an optical scanner.  Scanned image PDF documents are 
not text searchable and have a large file size.  Scanned PDFs up to 10 
megabytes may be uploaded as a single file; documents exceeding those 
limits should be split into separate files using appropriate identification of 
the files (that is, they should be identified by volume number).  Oversized 
files may also be compressed using Adobe Acrobat to comply with the 10 
megabyte limit.  See User’s Manual Part IV, Section I, for instructions on 
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compressing PDF files. 
 
B.  Hardware and Software 
 

The following hardware and software are needed for CM/ECF: 
 

1.  Personal Computer: You will need a personal computer running Windows, and 
equipped with Java 1.6 (or higher).  Macintosh users need OS X version 10.7 or 
higher with the most recent updates that include Java. The updates may uninstall 
the Java applet plug-in from all web browsers. When logging into CM/ECF it will 
say "Missing Plug-In" and will require the user to perform a one-time download 
from the Oracle web site to get the needed plug-in. Alternatively, Macintosh users 
may choose to run Windows emulation software such as Fusion, Parallels, or 
Bootcamp. 

 
2.  Word Processing Software: WordPerfect, Microsoft Word, or any other word 
processing software that will permit you to convert text documents to PDF may be 
used. 

 
3.  Internet Service Provider and Web Browser: CM/ECF has been certified to 
work with Mozilla Firefox versions 1.5 or higher and Internet Explorer version 7 or 
higher. 

 
4.  Email Account: On your PACER filing account, you may register more than one 
email address for receipt of Notices of Docket Activity.  The address(es) must be 
regularly monitored, however, as your only notification of case activity will be via 
email.  Counsel must also ensure that the spam filter operation on the network and 
computer receiving the email is set to allow notices from ca10.uscourts.gov.  

 
5.  PDF Conversion Software: WordPerfect version 9 and higher include the 
capability to convert text documents to PDF.  Microsoft Word 2007 and all later 
versions have the ability to convert documents to PDF. Word 2007 requires a 
plug-in that you can download for free from Microsoft's website.  Older versions of 
Word require a third-party plug-in such as Adobe Acrobat. There are also 
third-party applications that allow you to generate a PDF from a saved document, 
and many of these are free. 

 
Interactive on-line training on converting Word or WordPerfect documents to PDF 
is available at http://pacer.psc.uscourts.gov/ecfcbt/dc/cccnvtpdf/. 

 
6.  Scanner: A scanner will be necessary only if you need to include attachments to 
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pleadings that are not available in native PDF.  Paper documents should be scanned 
into PDF format at 300dpi. 

 
7.  Java Runtime Environment (JRE) 1.6: Java 1.6 or higher is required for 
CM/ECF to operate on your computer.  It is available at www.java.com.  Select 
ADo I Have Java@on the main screen to verify which version you currently have on 
your computer.  If you do not have Java 1.6, you will be prompted to download it.  
Mac users will need the 64-bit Macintosh with OS X 10.7 including the Apple-
supplied Java 1.6.  If you are a Mac user with an older 32-bit OS you will need to 
add additional software such as Fusion, Parallels, or Bootcamp that will allow 
Windows to run on a Mac. 

 
 
II.  POLICIES AND PROCEDURES FOR FILING VIA ECF 
(Incorporated from the Court=s Original Order on ECF filing dated 3/18/2009) 
 
A.  Scope of Electronic Filing 
 

1.  Effective Date:  Attorneys have been permitted to register on PACER as Filing 
Users since October 2008.  Filing in the CM/ECF System became mandatory 
for all counsel on June 1, 2009. 

 
2.  Persons Covered: All attorneys filing documents in the Tenth Circuit must file 
electronically using CM/ECF (regardless of when the case was opened initially) 
unless counsel applies for, and the Court grants, an exemption for good cause 
shown in a particular case.  Motions seeking an exemption may come in paper 
form.  See Fed. R. App. P. 25(a)(2)(D).  Pro se litigants may continue to file 
documents conventionally (i.e., in hard copy form).  A pro se litigant may, 
however, request permission to file documents electronically in an individual 
appeal or proceeding.  Pro se litigants seeking permission to submit documents via 
ECF should file a hard copy motion seeking permission at the earliest opportunity.  
If approved, the pro se litigant will be authorized to file via ECF in that matter 
only.   

 
3.  ECF Filing Requirements: All pleadings and other documents filed by counsel 
must be filed electronically in native PDF – please see below for additional filing 
information for particular cases/submissions: 

a.  Effective October 1, 2012, case initiating documents for original 
proceedings may be submitted via ECF/pay.gov (see this Users 
Manual at Section VIII for specifics on how to submit).  Materials 
falling into this category include petitions for review, petitions for 
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permission to appeal and original writs.  Please note that any 
accompanying appendices to the case initiating documents may 
now be submitted via ECF when using that option. Appendices 
filed with the Court electronically are limited to 10 megabytes per 
uploaded file.  More than one file may be uploaded to a particular 
entry, provided that the total file size does not exceed 50 megabytes 
per transaction.  Submission of case initiating documents via ECF is 
not mandatory at this time, however. Alternatively, these pleadings 
may be submitted in paper format or emailed to the Clerk at  
10th_Circuit_Clerk@ca10.uscourts.gov.  Pleadings forwarded on 
email should be in Native PDF format.  In addition, please note that 
submission of case initiating documents via ECF does not exempt the 
filing party from serving the documents via conventional methods.  
See User Manual Section II D 4. 

 
b.  Effective January 1, 2015, appendices submitted pursuant to Federal 
Rules of Appellate Procedure 30 and 10th Circuit Local Rules 9.2(B), and 
30 must be filed electronically.  With the exception of Rule 9.2(B) 
appendices, a single hard copy of any appendix filed must be also be 
received in the office of the Clerk within 2 business days of submission of 
the appendix and brief via ECF.   

 
c.  CJA vouchers are a hybrid.  For information regarding filing vouchers, 
please go to our website at www.ca10.uscourts.gov/clerk/rulesandforms.php 
and see our links to the relevant CJA materials.   

 
d.  Please note more than one file may be uploaded to a particular 
entry/option, provided the total transaction does not exceed 50 megabytes.  
Individual PDFs may not exceed 10 megabytes. Any attachment to a 
pleading exceeding 10 megabytes may not be submitted electronically, and 
should be divided into smaller PDFs that comply with the size limitations. 
Counsel seeking to submit attachments so large they cannot be filed via ECF 
must submit a motion prior to submission seeking exemption from the 
electronic filing requirements and justifying the need to submit attachments 
of this size.  
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B.  Eligibility, Registration, Passwords 
 

1.  Attorneys: Attorneys who are members in good standing of the Tenth Circuit 
Bar and who intend to practice in this Court must register as filing users of the 
Court=s CM/ECF System by following these steps [for additional information and a 
tutorial, please see the ACM/ECF & Court Filing@ tab on our website]: 
 

a.  Register with PACER for a PACER account: If you or your law firm 
have not previously obtained a PACER account (used to view documents), 
you must obtain a PACER account.  Register for a PACER account at the 
PACER Registration web site (http://pacer.gov).   

 
b.  Register with PACER for An Appellate Filer Account: In addition to 
having a PACER viewing account (as noted above) you will also need to 
register for an appellate filer account.  This account is required in order to 
file materials in ECF.  It is also required to view documents in social 
security and immigration cases in which you are participating.  This account 
also allows you to view sealed materials in cases in which you appear.  
Register for an appellate filer account at the PACER Service Center 
Appellate ECF Filer Registration web site (http://pacer.gov).  The 
registration process takes approximately five minutes. 

 
c.  Training: The court has made available several Captivate training 
modules for ECF users on its web site.  Counsel/Parties are strongly 
encouraged to take advantage of these training tools.  In addition, both the 
manual and a Frequently Asked Questions guide are available in ECF via 
the AHelp@ menu at the top of the screen. 

 
d.  Notification: After you have completed your Filer registration form, 
PACER will submit your information to the Court for approval.  
Registration requests are generally processed within 24 hours on business 
days.  You will receive notice via email when you are approved for 
electronic filing.  If your registration is rejected, you will be notified via 
email and informed what step(s) need to be taken to make the appropriate 
corrections.   

 
e.  Address, Email, Telephone Number Changes: Filing users must update 
personal, email, and address changes with the PACER Service Center.  If 
you do not, you may not receive notices of activity (NDAs) in the 
proceeding.  To update an account, go to the PACER Service Center 
www.pacer.gov and choose the AManage My Appellate Filer Account@ 
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option.  Generally, the court=s records will be updated within one business 
day after PACER=s receipt of the updated information.  Please note a hard 
copy or emailed change of address form submitted to the court will be 
insufficient to update personal and address changes in PACER.  ECF 
accounts that are not current are subject to being disabled by the court. 

 
2.  Pro Se Litigants: Pro se litigants are not required to file documents 
electronically and generally do not file via ECF.  However, should a pro se party 
wish to file electronically, he/she may (in fact, must) file a motion requesting 
permission to do so.  That motion should be submitted in paper form prior to 
registering.  The request to file electronically may be made only in a specific appeal 
or proceeding.  That is, the court will not entertain pro se motions to file in future 
cases or in cases in which the litigant is not a party.  If granted, the pro se litigant 
will be directed to register with PACER as a pro se appellate filer and will be 
permitted to submit documents via ECF in that case only.  The Court will terminate 
the pro se litigant=s filing user status upon the termination of the case or termination 
of the litigant=s pro se status. 

 
3.  Registration Constitutes Consent to Electronic Service: Completion of the 
appellate filer registration on PACER constitutes consent to electronic service of 
documents via CM/ECF. 

 
4.  Passwords: 

 
a.  Security: In registering, filing users agree to protect the security of their 
passwords.  Contact the PACER Service Center and the clerk immediately if 
you learn that your password has been compromised. 

 
b.  Changing Your Password: If you wish to change your password you will 
need to do so through your PACER Appellate Filer Account.  Log in to the 
APACER Appellate File Account Update@ AManage My Appellate Filer 
Account@ portion of the site to make a password change. 

 
c.  Forgotten Password: If you forget your password, you can retrieve it 
electronically through the Pacer Service Center Forgotten Password Request 
section of the website.  To retrieve your password, you will need your 
account ID, security question answer, and the email address and telephone 
number associated with your account.  

 
d.  Delegation of Authority to Use Login and Password: Administrative 
assistants, paralegals, or other authorized persons may use your login and 
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password to file documents on your behalf.  Remember, however, that a 
delegation to use your login and password to utilize the Court=s system 
constitutes an implicit agreement, by you, that there will be compliance with 
all rules and regulations governing CM/ECF.  The agreement to comply 
continues whether you are using the system personally or are delegating that 
authority to someone else. 

 
5.  Revoking E-Filing Privileges: The Court may revoke a filer=s privileges for 
good cause. 

 
C.  Consequences of Electronic Filing 
 

1.  Filing Complete at Date and Time Stated on Notice of Docket Activity: 
Electronic transmission of a document to CM/ECF, together with the transmission 
of the Notice of Docket Activity from the Court, constitutes filing of the document 
unless the pleading is subsequently cited as deficient under the Federal Rules of 
Appellate Procedure and/or local rules of the court, or unless hard copy follow-up 
is required (please see  this Manual at Part II, Section A, paragraph 3 with regard to 
these requirements--hard copies are required for briefs, appendices and petitions for 
rehearing but not for other pleadings). Electronic filing must be completed before 
midnight, Mountain Standard Time, as shown on the Notice of Docket Activity, to 
be considered timely filed on the day it is due. 

 
2.  Electronic Document is Official Record: When a document has been filed 
electronically, the official record is the electronic document stored by the Court.  
Counsel must take care to verify the accuracy of the electronic document before 
committing the transaction to the docket. 

 
 
D.  Service of Documents by Electronic Means 
 

1.  Service of Documents: The Notice of Docket Activity generated by the 
CM/ECF System constitutes evidence of service of the filed document on 
participants registered to receive materials electronically.  It is the responsibility of 
the Filer to confirm that service is effected.  If a party to the case is not registered to 
receive service via NDA, the Filer must serve that party in another appropriate 
mannerBeither via hard copy or email.  See 10th Cir. R. 25.4.   
 
2.  Preparing the Certificate of Service: A certificate of service must be attached as 
the final page to all documents filed with the Court, in accordance with Fed. R. 
App. P. 25(d)(1).   
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3.  Conventional Service Required for Those Not Registered as Filing Users: As 
noted, participants in a case not served through CM/ECF must be served 
conventionally.  

 
To determine whether case participants are registered to receive ECF 
service, and to confirm how service should be effected on each party, 
please use the AService Method Report@ available within CM/ECF 
under the Reports menu option.  If an attorney=s AECF Filing Status@ is 
active, he/she may be served via ECF; if not registered, service must be 
completed via other methods (e-mail, postal mail, etc.) 

 
4.  Conventional Service Required for Paper Filings: Documents filed in paper 
form must be served conventionally.  For example: 
 

a.  Case Initiating Documents: Regardless of whether case initiating 
documents are submitted to the court via ECF or are filed in paper form, or 
via email (in PDF format), with the Clerk, copies must be served via 
conventional methods in paper form or via email.  

 
 

5.  Three Days Added to Prescribed Period if Service was by Electronic Means: 
Under Fed. R. App. P. 26(c), when a party is required or permitted to act within a 
prescribed period after a paper is served, three calendar days are added unless the 
paper is delivered on the date of service.  Please note that under this rule, a 
paper that is served electronically is not treated as delivered on the date of 
service. 

 
E.  Entry of Court-Issued Documents 
 

Court orders, opinions, judgments, and all other documents are filed on the docket 
electronically and are forwarded to the parties electronically (via a Notice of 
Docket Activity).  The court makes exceptions if the participant does not have an 
email address.  In that case, the relevant Order or Opinion, etc., will be forwarded 
in hard copy via regular postal mail. 

 
F.  Attachments and Exhibits to Pleadings 
 

1.  Electronic Filing Required: All attachments and exhibits to pleadings must be 
filed in electronic form unless otherwise directed by the Court. 
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2.  PDF required: All attachments and exhibits must be filed in PDF format.  The 
Court prefers that attachments be submitted in native PDF; however, if attachments 
are not available in native PDF, they may be submitted in scanned PDF. 

 
3.  File Size: Documents filed with the Court electronically are limited to 10 
megabytes per uploaded file.  More than one file may be uploaded to a particular 
entry, provided that the total file size does not exceed 50 megabytes per transaction.  

 
4.  Multiple Attachments/Exhibits: If possible, all attachments/exhibits to a 
document should be merged into a single PDF for filing. That document may not, 
however, exceed 10 megabytes.  If the size limit would be exceeded by merging the 
materials into a single PDF, the attachments may be divided into two (or more, if 
size warrants) separate PDFs.  Each PDF may be uploaded using the AAdd 
Another@ button within the ECF docket entry.  After uploading each file, use the 
text box to properly describe each file (that is, you may edit the text in that box to 
identify and name the attachment). 

. 
NOTE: Large PDFs may be reduced in size by using Adobe Acrobat=s built-

in AOptimize Scanned PDF@ option under the View and Tools menu.  
See this Manual, Part IV, Section I for complete instructions on 
compressing files. 

 
G.  Filing Sealed Documents (Including Filing a Motion to Seal a Document) 
 

After logging into CM/ECF and entering your appeal number, select the ASealed 
Briefs and Motions@ category.  These events were specifically designed to allow for 
submission of sealed pleadings and briefs.  You may file a sealed motion, response, 
or brief in this manner.  Failure to select the ASealed Briefs and Motions@ category 
will result in your pleading being filed as a public document.  Counsel are 
responsible for ensuring that sealed materials are filed using these events.  In 
addition, please note that if you are submitting a motion to seal materials 
simultaneously with the sealed materials themselves, you should use these 
events.  That is the case even if the motion to seal is not submitted as sealed.  
You may file the sealed materials as an attachment to the Asealed motion filed@ 
docket event. 

 
H.  Signatures 
 

1.  Use of Digital Signature: The name/signature block of the filing user under 
whose login and password the document is submitted must be preceded by an As/@ 
and typed in the space where the signature would otherwise appear.  That is, the 
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signature should appear at the conclusion of the document as it would in a hard 
copy of the pleading.   

 
All ECF submissions requiring a signature shall be signed in the following  
manner: 

s/ Attorney (or where applicable, pro se party) 
Street Address 
Telephone Number 
Email Address 

 
2.  Documents Requiring Multiple Signatures: Documents requiring signature by 
more than one party may be completed via the use of digital signature (including 
the name of the party preceded by an As/@ and typed in the space where the 
signature would otherwise appear). 

 
I.  Certification 
 

In addition to a certificate of service, all ECF pleadings must include an additional 
certification, in the pleading, confirming that:  
 

a. all required privacy redactions have been made.  In this regard, please see 
section K of this manual.  In addition, please see Fed. R. App. P. 25(a)(5).  
Required redactions include social security numbers and taxpayer 
identification numbers (filers may disclose the last four digits of a social 
security or tax identification number), birth dates (use year of birth only), 
and financial account numbers (except those identifying property alleged to 
be subject to forfeiture in a forfeiture proceeding).  It is the sole 
responsibility of the filer to redact pleadings appropriately.  See also  Fed. R. 
Civ. P. 5.2; Fed. R. Crim. P. 49.1; Fed. R. Bankr. P. 9037.  

 
b.  the hard copies of any pleading required to be submitted to the 

   clerk=s office are exact copies of the ECF filing (that is, for ECF   
pleadings which also require submission of hard copies, the filer   

  must include written certification in the pleading that the electronic   
  copy and the required hard copies are exactly the same); 
 

c.  the ECF submission was scanned for viruses with the most recent version 
of a commercial virus scanning program (naming the program, version, and 
the date of the most recent update), and, according to the program is free of 
viruses. 
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J.  Technical Failures 
 
A party or attorney adversely affected by a technical failure in connection with 
filing or receipt of an electronic document may seek relief by appropriate motion. 

 
K.  Public Access, Privacy Protection and Redactions 
 

1.  Information Publicly Available on Internet: Counsel should exercise caution 
with regard to inclusion of sensitive personal data in filings.  It is counsel=s 
responsibility to follow the privacy and redaction requirements of Fed. R. 
App. P. 25(a)(5), as well as applicable federal rules of civil procedure, criminal 
procedure and the relevant bankruptcy rule.  See Fed. R. Civ P. 5.2; Fed. R. 
Crim. P. 49.1; Fed. R. Bankr. P. 9037.  Required redactions include social 
security numbers and taxpayer identification numbers (filers may disclose the 
last four digits of a social security or tax identification number), birth dates 
(use year of birth only), minors= names (initials may be used), and financial 
account numbers (except those identifying property alleged to be subject to 
forfeiture in a forfeiture proceeding).  Counsel should note the clerk will not 
review documents for redaction or sealing. 

 
2.  Sealed Cases, Immigration and Social Security Cases:  

 
Immigration and Social Security Cases. 

 
Remote public access (that is, PACER access) to electronic documents in 
immigration and social security cases is limited to orders, opinions, and 
other documents which the Court issues.  Remote electronic access to other 
materials (i.e., pleadings which the parties file and the record) is available 
only to parties and attorneys who have entered an appearance in the case and 
who are registered to file via CM/ECF.   

 
Sealed Materials and Sealed Cases 

 
With regard to all sealed materials, parties should note remote public  access 
(that is, PACER access) is available only to parties and attorneys in the case 
who have entered an appearance and who are registered to file via CM/ECF. 

 
3.  Establishing the Required Link Between ECF and PACER Accounts :  After the 
court approves your ECF registration you will need to link your ECF account to 
your PACER account.  This is quite important, as it will be the only way you 
will be able to view sealed pleadings in a case if you are counsel of record. 
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You will only need to do this once.  To link your accounts, please do the following: 
 

a.  Log into ECF. 
b.  Select APACER Report@ from the Reports Menu. 
c.  The PACER login screen will appear.  Enter your PACER login and 
password, and check the AMake this my default PACER login@ box. 
d.  Click Login. 
e.  You will need to log out of ECF and log back in for the change to take 
effect. 

 
You will now be able to access PACER directly from your ECF account.  If you 
are counsel of record in a case, this is the only way you will be able to view 
sealed documents in that proceeding.  Please note you will not be able to view 
sealed materials in your case if you access the docket via the public PACER 
site.  

 
L.  Address, E-Mail, Telephone Number Changes 
 

Filing users must update personal, email, and address changes with the PACER 
Service Center.  If you do not, you may not receive notices of activity (NDAs) in 
the proceeding.  To update an account, go to the PACER Service Center 
www.pacer.gov and choose the AAppellate CM/ECF Filer Account Update@ 
AManage My Appellate Filer Account@ option.  Generally, the court=s records will 
be updated within one business day after PACER=s receipt of the updated 
information.  Please note a hard copy or emailed change of address form 
submitted to the court will be insufficient to update personal and address 
changes in PACER.  ECF accounts that are not current are subject to being 
disabled by the court. 

 
M.  Review of Electronically Filed Pleadings 
 

The clerk=s office will review all pleadings submitted via ECF to ensure 
compliance with appropriate appellate and local rules, and to ensure that each 
pleading was filed correctly.  Should a document be deemed noncompliant, counsel 
will be contacted and instructed to re-file the pleading.  

 
N.  Interested Parties to an Appeal 

 
Individuals wishing to register as Ainterested parties@ for particular cases may do so 
via the PACER Service Center site (registering as an interested party allows the 
registrant to receive public NDAs issued in a particular proceeding).  Registering as 
an interested party may be a good option for counsel wishing to follow a related 
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case, or an appeal raising a significant issue of interest. 
 

Attorneys who are registered with ECF may add themselves to the notice list for 
cases in which they are not involved by selecting ANotice for Cases of Interest@ 
from the Utilities menu option and following the directions on the screen.  Please 
note, however, that interested parties are not considered Aof record.@  As a result 
they cannot file pleadings, nor will they have the Aone free look@ available when 
NDAs are issued.  Likewise, they will not be able to view sealed materials.  Pro se 
individuals who have received permission to use ECF in a given case will not be 
able to add themselves as interested parties to other cases.  Please note that only 
one email address per account will be able to receive Ainterested party@ notices. 

 
O.  Commercial URLs  
 

You may not be able to upload a PDF to ECF if the PDF contains an active link to 
a commercial URL. Please prepare accordingly.  You may create hyperlinks to 
documents being filed as attachments to your pleading, or to documents already 
attached to the docket.  See this manual, Part IV, Section H, for complete 
instructions on hyperlinking your filings. Please note hyperlinking is optional at 
this time.  

 
P.  CJA Attorneys With Two PACER Accounts 
 

CM/ECF allows a filing attorney to permanently associate a PACER login with an 
ECF filing login. The ECF filing login and PACER login became associated by checking 
the box AMake this my default PACER login@ during a previous session. When the two are 
associated, each time the attorney logs in to file a document the system also automatically 
logs the attorney in as a PACER customer. This is a helpful tool for attorneys who always 
use the same PACER account.  For attorneys who must switch between PACER viewing 
accounts, however, based on the type of work they are performing (for example, working 
on one case as court-appointed counsel while working on another as retained counsel), this 
default association may require updating.  In this regard, please see the instructions below. 
 

If you have linked your PACER account with your ECF account, and you need to 
un-associate the two accounts, please follow these steps: Log in to your ECF account, 
click on AUtility@ in the menu and select AUpdate My Account.@  Check the box next to 
ARemove the Default PACER Login@ and click the AApply@ button.  After doing this, you 
will be prompted to enter a login name and password each time you access PACER 
via your ECF account. 
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Q.  Metadata 
 

Metadata is additional data about a document that software like Word, WordPerfect 
and Acrobat automatically stores inside the document.  It can be anything from the name 
of the document's author to change tracking information and even previous versions of the 
document.  The court does not review pleadings filed via ECF for sensitive metadata, nor 
does it takes steps to protect metadata in pleadings filed via ECF.  As such, it is the filer=s 
responsibility and duty to protect and/or remove metadata in anything filed with the court. 
 
R.  Appendices 
 
 Effective January 1, 2015, all appendices accompanying briefs must be filed 
electronically. In addition, a single paper copy of the appendix (an exact replica of the 
electronic version; simply stated, if you file two volumes of an appendix electronically, 
you must file two volumes of a paper appendix- the number of volumes filed and the 
content must be identical) must be received in the clerk’s office within two business days 
of the electronic submission. Appendices must be in searchable (i.e. native) PDF format, 
and must be bookmarked. The first volume of each appendix must include a certificate of 
service and additional certifications as outlined previously in Section II (I).  See Section 
III (7) below for additional information. 
 

Counsel is encouraged to use the “Create an Appendix” feature available via 
district court ECF.  However, this method of compiling pleadings for inclusion in an 
appendix is not required; should counsel have a method that is more efficient for their 
situation (for example, compiling a paper appendix, then scanning it to PDF), they are 
encouraged to do so. 
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III.  CM/ECF Document Filing and Information Checklist** 
 
1.  Case Initiating Documents 

 
G Parties are not permitted to initiate appeals via ECF.   
G The clerk=s office will open all appeals upon receipt of materials forwarded 

from the district courts, and will notify parties of the case opening via a 
Notice of Docket Activity or US Mail if no email address is on file. 

G Original proceedings such as petitions for permission to appeal, applications 
for enforcement, petitions for mandamus/prohibition, petitions for 
successive habeas corpus and the like, may be submitted via ECF (see 
instructions on page 78).  Alternatively, parties may file the original  
petition/application in paper form with the clerk=s office OR email it to the 
Clerk in native PDF format (email address is: 
10th_Circuit_Clerk@ca10.uscourts.gov).  The clerk=s office will open the 
matter and will notify all parties. 

 
2.  Notice Of Appeal 
 

G Notices of Appeal should be filed electronically in the district court. 
G The clerk=s office will open all appeals upon receipt of materials forwarded 

from the district courts, and will notify parties of the case opening via a 
Notice of Docket Activity or US Mail if no email address is on file. 

 
3.  Preliminary Documents 
 

G Required preliminary documents include the entry of appearance, docketing 
statement, transcript order form, and designation of record. 

G These pleadings must be filed electronically in the court of appeals via ECF. 
G Pleadings must be filed in native PDF and must meet the size requirements 

of the system. 
G Attachments should be filed as part of the ECF docket event/option for the 

particular pleading, using the Aattach additional forms@ feature. 

                                                 
**  The court=s former General Order dated March 18, 2009, has been fully 

incorporated into this manual and is no longer an active Order.  For convenience, 
however, a copy has also been included at the end of the manual. 
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G Attachments available in native PDF should be included in the same file as 
the pleading (unless size restrictions are implicatedBplease see below). 

G Attachments may be submitted as additional files if they are in a non-
searchable format or if size limitations prevent inclusion with the primary 
pleading. 

G Parties do not need to submit any hard copies of preliminary documents. 
 
4.  Motions, Responses, Replies 
 

G These pleadings are filed electronically in the court of appeals via ECF. 
G They must be filed in native PDF and must meet the size requirements of the 

system. 
G Attachments should be filed as part of the AMotion Filed@ or 

AResponse/Reply@ events/options, using the Aattach additional forms@ 
feature. 

G Attachments available in native PDF should be included in the same file as 
the primary pleading. 

G Attachments may be submitted as additional files if they are in non-
searchable format or if size limitations prevent their inclusion. 

G Parties do not need to submit paper copies of motions, responses or replies. 
 
5.  Briefs 
 

G Briefs must be filed electronically in the court of appeals via ECF. 
G Briefs must be filed in native PDF format and must meet the size 

requirements of the system. 
G Briefs may contain hyperlinks to documents already on the docket or to 

attachments to the brief being filed. Consequently, if you plan on 
hyperlinking to an appendix, you must first file the appendix using the 
court’s ECF system.  Once the appendix is filed, you may then create 
hyperlinks in your brief to the docketed appendix volumes.  See this Manual, 
Part IV, Section H for instructions on creating hyperlinks. 

G If you have insufficient time to create hyperlinks to the appendix at the time 
of the original electronic filing, you may, by motion, request leave to file a 
substitute hyperlinked brief. Any motion in this regard must be filed via 
ECF within 7 days of the original electronic filing of the brief. Submission 
of a substitute hyperlinked brief does not toll or otherwise impact any other 
filing deadlines.  

G Attachments to briefs should be submitted as follows: 
 

 Attachments available in native PDF should be included in the 
same PDF file as the brief. 
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 Attachments which are not available in native PDF, and which 

must be scanned, may be submitted as a separate PDF file.  
Attachments may also be submitted in a separate file if the size 
limitations of the system require separate submission.   

 
G All filers must also submit to the clerk=s office seven paper copies of the 

brief, in the exact form in which it was filed via ECF.  Those hard copies 
must be received in the clerk=s office within two business days of the ECF 
filing. 

 
6.  Sealed Briefs  

(Sealed filings other than briefs are referenced in paragraph 9 below.) 
 

G Sealed briefs must be filed electronically in the court of appeals via ECF 
using the appropriate ASealed Brief Filed@ event.  The failure to use a 
Asealed@ event category will result in a public submission. 

G Sealed briefs must be filed in native PDF format and must meet the size 
requirements of the system. 

G Briefs may contain hyperlinks to documents already on the docket or to 
attachments to the brief being filed. Consequently, if you plan on 
hyperlinking to an appendix, you must first file the appendix using the 
court’s ECF system.  Once the appendix is filed, you may then create 
hyperlinks in your brief to the docketed appendix volumes.  See this Manual, 
Part IV, Section H for instructions on creating hyperlinks. 

G If you have insufficient time to create hyperlinks to the appendix at the time 
of the original electronic filing, you may, by motion, request leave to file a 
substitute hyperlinked brief. Any motion in this regard must be filed via 
ECF within 7 days of the original electronic filing of the brief. Submission 
of a substitute hyperlinked brief does not toll or otherwise impact any other 
filing deadlines.  

G Attachments to sealed briefs should be submitted as follows:  
 

 Attachments available in native PDF should be included in the 
same PDF file as the brief 

 
 Attachments which are not available in native PDF, and which 

must be scanned, may be submitted as a separate PDF file.  
Attachments may also be submitted in a separate file if the size 
limitations of the system require separate submission.   

 
G All filers must also submit to the clerk=s office seven paper copies of the 
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brief, in the exact form in which it was filed via ECF.  Those hard copies 
must be received in the clerk=s office within two business days of the ECF 
filing. 

 
G Parties seeking to submit a motion to seal the brief simultaneously with the 

brief should use the appropriate Asealed@ event/option even if the motion is 
not submitted as sealed. 

 
7.  Appendices 
 

G Appendices filed per Federal Rules of Appellate Procedure 10 and 30 and 
10th Circuit Rules 9.2(B), 10 and 30 must be filed electronically via ECF.  
Hyperlinks are optional, but if they are used parties should note that for 
technical reasons only materials already on the docket may be hyperlinked. 
Consequently, in order to create hyperlinks in a brief all volumes of the 
appendix must already be on the CM docket.  

G Parties are required to use native (i.e., searchable) PDFs in the electronic 
appendix, and to bookmark each volume accordingly.  Parties may use the 
district court’s “Create Appendix” option to assemble an appendix using the 
PDF files from that court.  Using this option will automatically create 
bookmarks in the appendix.  It may be necessary to edit the bookmarks to 
correctly describe the pleadings. See User’s Manual Part IV, Section J for 
details on using the “Create Appendix” option. Note that using the “Create 
Appendix” feature is not required; should counsel have a method that is 
more efficient for their situation (for example, compiling a paper appendix, 
then scanning it to PDF), they are encouraged to do so. 

G Parties must compile any sealed materials required for the appendix in a 
separate PDF.   

G Parties must include a certificate of service and certificates of compliance,  
privacy redaction, virus scan, and hard copy in the first volume of the 
appendix (see section II (I) for specifics on the required certifications). 

G A paper copy of the appendix, which is an exact replica of the electronic 
filing, must be submitted to the court of appeals clerk’s office. Simply 
stated, if you file two electronic volumes with the court, you need to file two 
paper volumes.  The number of volumes and the content must be identical.

G If the filing is an appendix due at the time a brief is filed, the paper copy 
must be received in the court of appeals within two business days of the 
ECF filing. 
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8.  Supplemental Authorities, Status Reports, Memoranda, Correspondence 
 

G These materials must be filed in the court of appeals via ECF. 
G All supplemental authorities, status reports, other memoranda or 

correspondence must be filed in native PDF and must meet the size 
requirements of the system. 

G Attachments to these pleadings should be filed as part of the docket 
event/option, using the Aattach additional forms@ feature. 

 
G Attachments which are available in native PDF should be 

included in the same PDF file as the original pleading. 
 
G Attachments which are not available in native PDF, and which 

must be scanned, may be submitted as a separate PDF file.  
Attachments may also be submitted in a separate file if the size 
limitations of the system require separate submission. 

 
G Parties do not need to submit paper copies of supplemental authorities, 

status reports, memoranda or correspondence. 
 
9.  Sealed Materials with the Exception of Briefs 

(See paragraph 6 above for information on filing sealed briefs via ECF.) 
 

G Sealed materials must be filed electronically in the court of appeals via ECF 
using the appropriate ASealed Pleadings@ event/option.  Failure to use a 
Asealed@ event category will result in a public submission. 

G Sealed pleadings must be filed in native PDF and must meet the size 
requirements of the system. 

G Attachments to sealed pleadings and materials should be filed as part of the 
docket event/option, using the Aattach additional forms@ feature.  In 
particular, please note: 

 
G Attachments available in native PDF should be included in the 

same PDF file as the original pleading. 
 

G Attachments which are not available in native PDF, and which 
must be scanned, may be submitted as a separate PDF file.  
Attachments may also be submitted in a separate file if the size 
limitations of the system require separate submission. 

 
G Parties do not need to submit paper copies of sealed materials other than 
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briefs. 
G Parties seeking to submit a motion to seal the pleading simultaneously with 

the pleading itself should use the appropriate Asealed@ event/option even if 
the motion is not submitted as sealed.  For example, parties may use the 
ECF event/option ASealed Motion Filed@ and can include the pleading to be 
sealed as an attachment. 

 
10.  Oral Argument Acknowledgment Forms & Custody Status Questionnaires 
 

G Oral argument and custody status materials must be filed electronically in 
the court of appeals via ECF. 

G These materials must be filed in native PDF and must meet the size 
requirements of the system. 

G Attachments should be filed as part of the docket event/option, using the 
Aattach additional forms@ feature. 

 
G Attachments available in native PDF should be included in the 

same PDF file as the original pleading. 
 

G Attachments which are not available in native PDF, and which 
must be scanned, may be submitted as a separate PDF file.  
Attachments may also be submitted in a separate file if the size 
limitations of the system require separate submission. 

 
G Parties do not need to submit paper copies of oral argument and custody 

status materials. 
 
11.  Petitions For Rehearing and Rehearing En Banc 
 

G Petitions For Rehearing and Petitions For Rehearing En Banc must be filed 
electronically in the court of appeals via ECF. 

G These pleadings must be filed in native PDF and must meet the size 
requirements of the system. 

G Attachments should be filed as part of the docket event/option, using the 
Aattach additional forms@ feature. 

 
G Attachments available in native PDF should be included in the 

same PDF file as the original pleading. 
 

G Attachments which are not available in native PDF, and which 
must be scanned, may be submitted as a separate PDF file.  
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Attachments may also be submitted in a separate file if the size 
limitations of the system require separate submission. 

 
G Important note regarding hard copies: Parties filing petitions for panel 

rehearing only, per Fed. R. App. P. 40, do not need to submit any paper 
copies of the pleading.  Any party requesting rehearing en banc, per 
Fed. R. App. P. 35, however, must forward to the clerk=s office 12 paper 
copies of the petition, with attachments.  The hard copies must be 
received in the office of the clerk within two business days of the ECF 
submission.   

 
12.  Bills of Cost and Objections 
 

G Bills of Cost and objections to bills of costs must be filed electronically in 
the court of appeals via ECF. 

G These pleadings must be filed in native PDF and must meet the size 
requirements of the system. 

G Attachments should be filed as part of the docket event/option, using the 
Aattach additional forms@ feature. 

 
G Attachments available in native PDF should be included in the 

same PDF file as the original pleading. 
 

G Attachments which are not available in native PDF, and which 
must be scanned, may be submitted as a separate PDF file.  
Attachments may also be submitted in a separate file if the size 
limitations of the system require separate submission. 

 
G Parties do not need to submit hard copies of bills of costs or objections to 

bills of costs. 
 
13.  Criminal Justice Act Vouchers 
 

G Parties seeking information on submitting Criminal Justice Act vouchers 
should review the forms and procedures available on the court=s website at 
www.ca10.uscourts.gov/clerk/rulesandforms.php.  Specifically, counsel 
should go to the ACJA Forms and Links@ section.   

 
14.  Ex Parte Pleadings 
 

G Parties may not file ex parte materials via ECF. 
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G If it is necessary to file a pleading ex parte, counsel should submit the 
pleading in native PDF format via email to the clerk=s office. The proper 
email address is: 10th_Circuit_Clerk@ca10.uscourts.gov).  The clerk=s office 
will docket and then process the pleading.   
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IV.  HOW TO USE THE CM/ECF SYSTEM- 
EXAMPLES AND STEP-BY-STEP GUIDE 

 
As mentioned previously in this guide, attorneys must register as filing users of the 
Court=s CM/ECF System in order to obtain a Login name and Password.  Registration may 
be accomplished by visiting the Pacer web site (www.pacer.gov). 
 

 
 
Enter your Login name and password in the appropriate boxes on the Login screen.  Make 
sure to click the redaction rules box.  Click ALogin@ to proceed.  Note: the >client code= box 
does not need to be completed.  
 
 
The Startup Page will appear. 
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The menu options on the top of the screen are as follows: 
 

1. Filing- select to file in a case; 
2. Reports- select to be connected to Pacer, check payment history, or access the 
Service Method report; 
3. Utilities- select to edit/update your account information, request a            
certificate of good standing, or file an original proceeding; 
4. Logout- select to end your session; 
5. Help- select to access the courts= ECF training manual and FAQ. 
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Establishing Link Between ECF and PACER Accounts 
 
After your ECF registration has been approved by the court, you will need to link your 
ECF account to your PACER account.  This is quite important, as it will be the only way 
you will be able to view sealed pleadings in a case if you are counsel of record. 
 
You will only need to do this once.  To link your accounts, please do the following: 
 
1.  Log into ECF. 
 
2.  Select PACER Report from the Reports Menu. 
 
3.  The PACER login screen will appear.  Enter your PACER login and password, and 
check the AMake this my default PACER login@ box. 
 
4.  Click Login. 
 
5.  You will need to log out of ECF and log back in for the change to take effect. 
 

 
You will now be able to access PACER from your ECF account.  If you are counsel of 
record in a case, this is the only way you will be able to view sealed documents in the 
case.  You will not be able to view sealed documents in your case if you access the docket 
via the PACER site; you must access via your ECF account.  If you are with a law firm 
that has a single shared PACER account, you may use that shared account to link to your 
individual ECF account. 
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A.  Docketing a Pleading in a Case- The Basics 
 
 
1.  Select AFile a Document@ from the Docketing menu at the top of the Startup Page.  The 
following screen will appear: 
 

 
 
2.  Enter a case number in the Case field (make sure to use the correct formatB yy-nnnnB 
when entering the number in the field).  Click ATab@ on your keyboard. 
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3.  The case number and short title of the case will appear in the Case Selection box: 
 

 
 
 
 
 
4.  If a selected case has additional cases linked to it, those cases will also appear in this 
section.  To file in more than one case (for example, filing a brief in a cross-appeal or in 
two consolidated cases), you must check the box next to the appropriate case number; 
otherwise, your filing will only appear in the case number that you entered in the Case 
box.  Conversely, if you do not want your filing to appear in a linked case, you must 
uncheck the box for that case. 
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5.  Next, you will need to select an Event Category from the menu on the left side of the 
screen.  Selecting a category will bring up a number of docketing event options. 
 

 
 
Select the corresponding event option for the pleading you wish to file: 
 

 
 
Click >Continue= at the bottom of the screen. 
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6.  On the next screen, you will be prompted to select the party filer, attach the PDF for 
the pleading, and enter the date and method of service.  Depending on the type of pleading 
you are filing, you may be required to enter additional information.  

 
 
7.  To attach a PDF to your entry, click the >Browse= button in the PDF Document section 
on the screen.  This will cause a pop-up screen to appear.  Locate the appropriate PDF on 
your computer and select it.  You may leave AMain Document@ in the Description field, or 
you may edit to state what you are filing (for example, ADocketing Statement,@ 
AAppellant=s Brief,@ etc.). 
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If you are attaching more than one PDF (for example, you have two PDFs to submit- one 
containing the pleading, and one containing attachments to the pleading), you will need to 
click the >Add Another= button and repeat the process described above.  Please note: when 
adding a second (and subsequent) PDF, you must fill in the Description field. 
 

 
 
 
After you have completed all of the sections on the screen, click the >Continue= button at 
the bottom.  The >Back= button will take you back to the previous screen.  The ACancel= 
button will void the transaction. 
 
8.  Next, a Docket Text pop-up window will appear.  This will display how your entry will 
appear on the court=s docket.  Verify the information (pleading filed, filer name, service 
information, etc.) before clicking >Continue.=  If there are any errors, click the >Back= 
button to go back to the prior screen and make any necessary corrections.  Note- you will 
not be able to edit the docket text.  
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9.  The next screen that appears is the final Event Review screen. Selecting >Submit= 
completes the transaction.  Select >Back= if you have changes to make, or decide to cancel 
the transaction. 
 

 
 
10.  After selecting the >Submit= button, you should see the following message: 
 

 
 
In addition, for most transactions, the following screen will appear.  This is the Notice of 
Docket Activity (NDA).  You may close this screen after it appears. 
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Don=t forget to logout if you are finished! 
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B.  Filing a Brief 
 
1.  Select the AFiling A Brief@ category from the left side of the main screen.  Select the 
type of brief you are filing from the menu that appears on the right side of the main 
screen.  If your brief needs to be filed in more than one case (for example, a cross-appeal 
brief), select the additional cases in the Case Selection box.  Click >Continue.= 
 
In this example, we will file appellant=s opening brief. 
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2.  Select the party filer(s) in the top box.  If you represent more than one party, make sure 
that all of your parties are selected.  If a party you represent does not appear in the top 
box, add the party=s name in the text box immediately beneath this section.  
 

 
 
Attach the PDF containing your brief.  If your brief has an attachment, use the >Add 
Another= button to attach that PDF.  Complete the Description field for the attachment.  
 

 
 
Enter the number of paper copies of the brief that will be submitted to the clerk=s office 
(note: seven paper copies of all briefs must be submitted to the court within two business 
days of electronic filing of the brief). 
 
If filing a merits brief, you will need to indicate whether you are requesting oral argument 
from the Oral Argument drop-down menu. 
 
Complete the Service section by entering the date of service of the brief in the Service 
Date box, and selecting the appropriate boxes in the Service field indicating who was 
served and by what method (if relying on ECF for service, select Email).  Click 
>Continue.= 
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3.  Read the statements regarding privacy redactions, exact copies submitted, and scanning 
for viruses.  You will need to certify by selecting from the drop down menu that you have 
acknowledged the previous statements. 
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4.  Verify in the Docket Text pop-up window that you have selected the correct Brief 
event, that the party(ies) you represent is/are listed here, and that the service date and 
method of service are correct.  If so, click >Continue;= if not, click >Back= to return to the 
previous screen to make corrections. 
 

 
 
 
4.  The next screen that appears is the final Event Review screen. Selecting >Submit= 
completes the transaction.  Select >Back= if you have changes to make, or decide to cancel 
the transaction. 
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5.  If successful, you will see this message: 
 

 
 
 
6.  Click >OK= and the Notice of Docket Activity will appear.  You may close this screen 
after it appears. 
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C.  Filing a Motion 
 
1.  Select the AFiling A Motion Or Response@ category from the left side of the main 
screen.  Select AFile A Motion@ from the menu that appears on the right side of the main 
screen.  If your motion needs to be filed in more than one case (for example, a cross-
appeal), select the additional cases in the Case Selection box.  Click >Continue.= 
 
In this example, we will file appellant=s motion for extension of time to file appellant=s 
brief. 
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2.  Select the party filer(s) in the top box.  If you represent more than one party, make sure 
that all of your parties are selected.  If a party you represent does not appear in the top 
box, add the party=s name in the text box immediately beneath this section. 
 

 
3.  Next, you will need to select at least one relief (i.e., what you are requesting in your 
motion) from the Description drop-down menu.  You may use the Category drop-down 
menu to narrow the list of Descriptions.  Once you locate the most accurate description for 
what you are requesting in your motion, select it and click >Apply.=  Your selection will 
appear in the Selected Reliefs section.  
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If you are requesting more than one relief in your motion, you will need to repeat the 
Relief selection process as described above.  Click >Continue= when done. 
 
The Selected Reliefs section has four tabs on the right side of the menu: 

a.  Up/Down: when more than one relief is selected, the order of the reliefs may be 
changed using these tabs.  To move a relief up/down in the list, select the relief, 
followed by the Up or Down tab. 
b.  Remove: to remove a selected relief; select the relief you wish to remove from 
this section, followed by the Remove tab. 
c.  Clear All: will remove all selected reliefs. 

 
4.  Attach the PDF containing your motion.  If your motion has an attachment, use the 
>Add Another= button to attach that PDF.  Complete the Description field for the 
attachment.      
 

 
 
5.  Complete the Service section by entering the date of service of the motion in the 
Service Date box, and selecting the appropriate box in the Service field method of service 
(if relying on ECF for service, select >Email=).  
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6.  Read the statements regarding privacy redactions, exact copies submitted, and scanning 
for viruses.  You will need to certify by selecting from the drop down menu that you have 
acknowledged the previous statements.  Depending on the relief(s) you are requesting, you 
may have additional fields to complete.  In this example, the requested date for the 
briefing extension must be given.   
 

 
 
Click >Continue= when finished with this screen. 
 
7.  Verify in the Docket Text pop-up window that you have selected the correct event and 
relief, that the party(ies) you represent is/are listed here, and that the service date and 
method of service are correct.  If so, click >Continue;= if not, click >Back= to return to the 
previous screen to make corrections. 
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8.  The next screen that appears is the final Event Review screen. Selecting >Submit= 
completes the transaction.  Select >Back= if you have changes to make, or decide to cancel 
the transaction. 
 

 
 
9.  If successful, you will see this message: 
 

 
 
10.  Click >OK= and the Notice of Docket Activity will appear.  You may close this screen 
after it appears. 
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D.  Filing an Entry of Appearance 
 
1.  PLEASE NOTE: if you are not an existing counsel of record in a case, your entry of 
appearance must be submitted to the court via ECF and reviewed by a case manager 
before you will be able to docket any other pleadings in that case.  Please plan 
accordingly. 
 
2.  Select the APreliminary Appeal Documents@ category from the left side of the main 
screen.  Select AFile an Entry of Appearance@ from the menu that appears on the right side 
of the main screen.  If your pleading needs to be filed in more than one case (for example, 
a cross-appeal), select the additional cases in the Case Selection box.  Click >Continue.= 
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3.  Select the party filer(s) in the top box.  If you represent more than one party, make sure 
that all of your parties are selected.  If your party(ies) does not appear in the >Party Filer= 
section, please enter their name(s) in the first Additional Information section below. 
 

 
 
4.  Enter the name of the attorney(s) entering an appearance in the second Additional 
Information box. More than one attorney may enter his/her appearance on a single form; 
each attorney does not have to file the form on behalf of him/herself. 
 
5.  Attach the PDF containing your entry of appearance.  If your pleading has an 
attachment, use the >Add Another= button to attach that PDF.  Complete the Description 
field for the attachment. 
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6.  From the drop-down menu, indicate whether you are disclosing any interested parties 
on your entry of appearance form. 
 
7.  Complete the Service section by entering the date of service of the pleading in the 
Service Date box, and selecting the appropriate box in the Service field method of service 
(if relying on ECF for service, select >Email=).  Click >Continue.= 
 

 
 
8.  Verify in the Docket Text pop-up window that the party(ies) you represent is/are listed 
here, the full name(s) of all counsel entering an appearance appear, and that the service 
date and method of service are correct.  If so, click >Continue=; if not, click >Back= to return 
to the previous screen to make corrections. 
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9.  The next screen that appears is the final Event Review screen. Selecting >Submit= 
completes the transaction.  Select >Back= if you have changes to make, or decide to cancel 
the transaction. 

 

 
 
10.  If successful, you will see this message: 
 

 
 
 
11.  NOTE: You will not immediately receive a notice of docket activity from this event.  
A case manager in the clerk=s office will review the submission and issue a notice of 
docket activity upon completion of the review process. 
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E.  Filing a Response 
 
1.  Select the AFiling A Motion Or Response@ category from the left side of the main 
screen.  Select AFile A Response@ from the menu that appears on the right side of the main 
screen.  If your response needs to be filed in more than one case (for example, a cross-
appeal), select the additional cases in the Case Selection box.  Click >Continue.= 
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2.  Select the party filer(s) in the top box.  If you represent more than one party, make sure 
that all of your parties are selected.  If your party(ies) does not appear in the >Party Filer= 
section, please enter their name(s) in the first Additional Information section below. 
 
3.  In the Additional Information field, state the name of the pleading to which you are 
filing a response. 
 

 
 
4.  Attach the PDF containing your motion.  If your motion has an attachment, use the 
>Add Another= button to attach that PDF.  Complete the Description field for the 
attachment. 
 

 
 
5.  Complete the Service section by entering the date of service of the motion in the 
Service Date box, and selecting the appropriate box in the Service field method of service 
(if relying on ECF for service, select >Email=).  Click >Continue.’ 
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6.  Read the statements regarding privacy redactions, exact copies submitted, and scanning 
for viruses.  You will need to certify by selecting from the drop down menu that you have 
acknowledged the previous statements. Click ‘Continue.’ 
 

 
 
7.  Verify in the Docket Text pop-up window that you have selected the correct event, 
stated the correct pleading to which you are responding, that the party(ies) you represent 
is/are listed here, and that the service date and method of service are correct.  If so, click 
>Continue;= if not, click >Back= to return to the previous screen to make corrections. 
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8.  The next screen that appears is the final Event Review screen. Selecting >Submit= 
completes the transaction.  Select >Back= if you have changes to make, or decide to cancel 
the transaction. 
 

 
 
9.  If successful, you will see this message: 
 

 
 
10.  Click >OK= and the Notice of Docket Activity will appear.  You may close this screen 
after it appears 
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F.  Filing a Supplemental Authority 
 
1.  Select the AFed. R. App. P. 28(j) Letter@ category from the left side of the main screen.  
Select AFile a Supplemental Authority@ from the menu that appears on the right side of the 
main screen.  If your pleading needs to be filed in more than one case (for example, a 
cross-appeal), select the additional cases in the Case Selection box.  Click >Continue.= 
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2.  Select the party filer(s) in the top box.  If you represent more than one party, make sure 
that all of your parties are selected. 
 
3.  Attach the PDF containing your motion.  If your motion has an attachment, use the 
>Add Another= button to attach that PDF.  Complete the Description field for the 
attachment. 
 
4.  Complete the Service section by entering the date of service of the motion in the 
Service Date box, and selecting the appropriate box in the Service field method of service 
(if relying on ECF for service, select >Email=).  Click >Continue.= 
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5.  Verify in the Docket Text pop-up window that you have stated the correct event, that 
the party(ies) you represent is/are listed here, and that the service date and method of 
service are correct.  If so, click >Continue;= if not, click >Back= to return to the previous 
screen to make corrections. 
 

 
 
6.  The next screen that appears is the final Event Review screen. Selecting >Submit= 
completes the transaction.  Select >Back= if you have changes to make, or decide to cancel 
the transaction. 
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7.  If successful, you will see this message: 
 

 
 
8.  Click >OK= and the Notice of Docket Activity will appear.  You may close this screen 
after it appears. 
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G.  Other Hints and Tips 
(THINGS EVERY ECF FILER WILL WANT TO KNOW) 
 
1.  When filing a brief or motion under seal, make sure to select the >Sealed Briefs and 
Motions= category from the left side of the main menu.  If you do not do this, your 
pleading will not appear as sealed on the court=s docket. 
 

 
 
If you are filing a motion for permission to file a pleading under seal, and are submitting 
the pleading at the same time as the motion, make sure to use Afile a motion under seal@ 
and add the pleading to be sealed as an attachment to this event.  This way, both the 
motion and the pleading will be submitted under seal initially. 
 
2.  Please note that there are three options when filing a transcript order form- ATranscript 
Order Acknowledgment Form@ must be used when a transcript will be ordered; ANotice 
that a Transcript is Unnecessary@ must be used when not ordering a transcript; ANotice that 
Transcripts Are Already on File in District Court@ must be used when a needed transcript 
is already on file in district court. 
 
3.  Although you will receive a notice of docket activity when submitting an 
amicus/intervenor brief via ECF, the brief is not considered filed until a case manager in 
the clerk=s office reviews the brief and dockets it as Afiled.@  A notice of docket activity 
stating that the brief has been filed will be issued upon completion of the review process.   
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4.  The clerk=s office will review all pleadings to ensure compliance with appropriate 
appellate and local rules, and to ensure that each pleading was filed correctly.  Should a 
pleading be deemed noncompliant, counsel will be contacted and instructed to re-file the 
pleading.  
 
5.  If you are filing a motion for leave to file a pleading, please add the proposed pleading 
as an attachment to the Amotion filed@ docket event.  If the motion is granted, the clerk=s 
office will docket the pleading separately. 
 
6. When submitting an entry of appearance form, it is acceptable to have a single form 
contain multiple attorney names.  Each attorney does not have to file a separate entry of 
appearance form. 
 
7. ECF is built to permit filing from a single attorney and the party(ies) that attorney 
represents and was not designed for Ajoint filings.@  As such, should you have a joint 
pleading to file, please have one attorney file on behalf of the parties he represents.  When 
the court reviews the pleading, it will adjust the docket entry to reflect that it is, in fact, a 
Ajoint@ filing. 
 
8. Only counsel of record will have the ability to file in a sealed case; this restriction 
extends to entries of appearance.  If you are an attorney entering your appearance in a case 
and you have not appeared in the case previously, you will need to have counsel of record 
file your entry of appearance on your behalf.  Once you are formally added to the case, 
you will be able to file all pleadings in the case.  
 
9.  Effective October 1, 2012, case initiating documents for original proceedings may be 
submitted via ECF/pay.gov (see ECF User=s Manual Section VIII for specifics on how to 
submit).  Materials falling into this category include petitions for review, petitions for 
permission to appeal and original writs.  In this regard, please note that any 
accompanying appendices for case initiating documents may now be submitted via 
ECF when using that option. Appendices filed with the Court electronically are limited 
to 10 megabytes per uploaded file.  More than one file may be uploaded to a particular 
entry, provided that the total file size does not exceed 50 megabytes per transaction.  
Submission of such case initiating documents via ECF is not mandatory at this time, 
however. Alternatively, these pleadings may be submitted in paper format or emailed to 
the Clerk at  10th_Circuit_Clerk@ca10.uscourts.gov.  Pleadings forwarded on email 
should be in Native PDF format.  In addition please note that submission of case initiating 
documents via ECF does not exempt the filing party from serving the documents via 
conventional methods.  See User Manual Section II D 4. 
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H.  HOW TO CREATE HYPERLINKS IN YOUR DOCUMENTS 
 
The instructions below describe how to create a hyperlink in a PDF document.  The 
hyperlink will connect the reader to another PDF document on file in the court’s CM/ECF 
filing database.  The hyperlinked document can be a document that was previously filed, 
like an appendix, or a document that is being filed with the current PDF document.  For 
example, you could create a hyperlink in your brief to an order submitted as an attachment 
to the brief.  In order to hyperlink, both documents must already docketed in the CM 
system (either previously filed, like an appendix, or filed in the same docket event, like an 
attachment). To create hyperlinks to an appendix you must first docket that pleading then 
create the links. The steps used to create a hyperlink and to generate documents in PDF 
format are similar whether using Word or WordPerfect.  Both will be covered in this 
section. 
 
 
CREATING A HYPERLINK TO A DOCUMENT ALREADY FILED IN A 
CASE 
 

1. Access CM/ECF and create a docket report for the case in which the document was 
filed. 
 

2. Scan the docket to find the correct document. 
 

3. Copy the URL of the document to the clipboard by doing the following: 
 

a. Hover over the document link and click the right mouse button. 
 

b. From the pop-up menu, choose Copy Shortcut or Copy Link Location, or 
Copy Link Address (the option you see depends on the browser you are 
using.) 
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c. If the docket event has multiple attachments, double click on the file icon 
and a new window will open.  From the list of documents, hover over the 
correct document link, and follow the steps listed above in 3(b). 
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CAUTION:  DO NOT copy the URL from the browser’s address bar when the document is open. 

4. Open the word processing document where you will be pasting in the link. 

 
5. In the document, highlight the citation text for which you want to create the 

hyperlink. 
 

 
 

6. The next section will cover how to create a hyper link and PDF document using 
WordPerfect.  If you are using Word, you may skip ahead to the Word instructions. 
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To Create the Hyperlink and Produce a PDF in WordPerfect 
1. From the Tools menu, choose Hyperlink.  The Hyperlink Properties dialog box 

opens. 
 

2. Press Ctrl-V to paste the URL into the Document/Macro field. 

 
3. If the citation is to a specific page in the document, append the following string to 

the URL to identify the page: ?page=x 
For example: 
https://ca10db.ca10.gtwy.dcn/docs1/01009175943?page=12 
 
NOTE:  Because of an incompatibility issue between Internet Explorer and Adobe 
Acrobat, the page number pointer will not work if the user opens the document 
with Internet Explorer. 
 

4. Click the OK button.  In the word processing application, the hyperlink text is now 
underlined and blue (or the color that you specified for hyperlinks), indicating a 
hyperlink has been created. 

 
5. Save the word processing document. 

 
6. Produce the PDF file. 

https://ca10db.ca10.gtwy.dcn/docs1/01009175943?page=12
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CAUTION:  Do not use the Print option in the word processing program. 
 
You must use the option of Publish to PDF or the Publish to option on the File 
Menu, and then choose PDF. 
 
If your version of WordPerfect does not have one of these Publish options, you 
must upgrade to Version 11 or higher. 

Your PDF document with hyperlinks is now ready to be filed. 
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To Create the Hyperlink and Produce a PDF in Word 
 

1. From the Insert menu, choose Hyperlink.  The Insert Hyperlink dialog box 
opens. 
 

2. Press Ctrl-V to paste the URL into the Address field. 
 

 
 

3. If the citation is to a specific page in the document, append the following string to 
the URL to identify the page:  ?page=x 
For example: 
https://ca10db.ca10.gtwy.dcn/docs1/01009175943?page=12 
 
NOTE:  Because of an incompatibility issue between Internet Explorer and Adobe 
Acrobat, the page number pointer will not work if the user opens the document 
with Internet Explorer. 
 

  

https://ca10db.ca10.gtwy.dcn/docs1/01009175943?page=12
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4. Click the OK button.  In the word processing application, the hyperlink text is now 
underlined and blue (or the color that you specified for hyperlinks), indicating a 
hyperlink has been created. 

 
5. Save the word processing document. 

 
6. Produce the PDF file by following the steps below. 

 
CAUTION:  Do not use the Print option in the word processing application. 
 
If you are using a version of Word that has an Adobe PDF menu, choose the 
Convert to Adobe PDF option. 
 
If your version does not have the Adobe PDF menu, close the Word file and follow 
the steps below. 
 

a. Open Adobe Acrobat. 
 

b. From the File menu, choose Create PDF > From File. 
A navigation dialog box opens. 
 

c. In the navigation dialog box, find and select the document that you want to 
convert to PDF, the click the Open button. 
 
(A series of dialog boxes will open while the document is converted to 
PDF.) 
 

d. When the conversion is complete, save the PDF file in the directory of your 
choice. 

Your PDF document with hyperlinks is now ready to be filed. 



 
 65 

CREATING HYPERLINKS BETWEEN DOCUMENTS IN THE SAME 
FILING 
 
Instead of linking to a previously filed document, you can link a PDF document to another 
document that you will be filing as an attachment at the same time.  For example, you 
could create a hyperlink from your brief to an order being submitted as an attachment to 
the brief. 
 
When you create the link on your local system, the link will be converted to an “address” 
in CM/ECF. 

1. Create PDF versions of any secondary documents, such as attachments or exhibits, 
that will be referenced by the main document. 
 

2. Open the main document in the word processing application. 
 
The main document will have the hyperlinks to the secondary documents. 
 

3. In the main document, highlight the text for which you want to create the hyperlink 
to the secondary document. 

 
 
To Create the Hyperlink to an Attachment and Produce a PDF in WordPerfect 
 

1. From the Tools menu, choose Hyperlink.  The Hyperlink Properties dialog box 
opens. 
 

2. Click the folder icon to the right of the Document/Macro field. 
 
The Select File window opens. 
 

3. Navigate to and select the PDF file that you want to link to and click the Select 
button. 
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The Document/Macro field now shows the file you selected. 

 
 

4. If the citation is to a specific page in the document, append the following string to 
the URL to identify the page:  ?page=x 
For example: 
F:\ECF Submissions\A5EOA.pdf?page=12 
 
NOTE:  Because of an incompatibility issue between Internet Explorer and Adobe 
Acrobat, the page number pointer will not work if the user opens the document 
with Internet Explorer. 
 

5. Click the OK button.  In the word processing application, the hyperlink text is now 
underlined and blue (or the color that you specified for hyperlinks), indicating a 
hyperlink has been created. 

 
 

6. Save the word processing document. 
 

7. Produce the PDF file. 
 
CAUTION:  Do not use the Print option in the word processing program. 

https://ca10db.ca10.gtwy.dcn/docs1/01009175943?page=12
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You must use the option of Publish to PDF or the Publish to option on the File 
Menu, and then choose PDF. 
 
If your version of WordPerfect does not have one of these Publish options, you 
must upgrade to Version 11 or higher. 

Your PDF document with hyperlinks is now ready to be filed. 
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To Create the Hyperlink to an Attachment and Produce a PDF in Word 
 

1. From the Insert menu, choose Hyperlink.  The Insert Hyperlink dialog box 
opens. 
 

2. Navigate to and select the PDF file that you want to link to. 
 

3. The Address field in the Insert Hyperlink dialog box now shows the file you 
selected. 
 

 
 

4. If the citation is to a specific page in the document, append the following string to 
the URL to identify the page:  ?page=x 
For example: 
F:\ECF Submissions\A5EOA.pdf?page=12 
 
NOTE:  Because of an incompatibility issue between Internet Explorer and Adobe 
Acrobat, the page number pointer will not work if the user opens the document 
with Internet Explorer. 
 

5. Click the OK button.  In the word processing application, the hyperlink text is now 
underlined and blue (or the color that you specified for hyperlinks), indicating a 
hyperlink has been created. 

https://ca10db.ca10.gtwy.dcn/docs1/01009175943?page=12
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6. Save the word processing document. 
 

7. Produce the PDF file by following the steps below. 
 
CAUTION:  Do not use the Print option in the word processing application. 
 
If you are using a version of Word that has an Adobe PDF menu, choose the 
Convert to Adobe PDF option. 
 
If your version does not have the Adobe PDF menu, close the Word file and follow 
the steps below. 
 

e. Open Adobe Acrobat. 
 

f. From the File menu, choose Create PDF > From File. 
A navigation dialog box opens. 
 

g. In the navigation dialog box, find and select the document that you want to 
convert to PDF, the click the Open button. 
 
(A series of dialog boxes will open while the document is converted to 
PDF.) 
 

h. When the conversion is complete, save the PDF file in the directory of your 
choice. 

Your PDF document with hyperlinks is now ready to be filed. 
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I. HOW TO COMPRESS LARGE PDF DOCUMENTS 
 
The following section will describe to how compress large PDF documents into smaller 
files to be filed using the court’s CM/ECF system. The maximum file size the court’s 
CM/ECF filing system will accept for each PDF attachment is 10 MB. Please be aware 
that due to user’s internet speeds, uploading large PDF files may take longer.  Because of 
this issue it is helpful to reduce the file size using Adobe Acrobat.  Users will need Adobe 
Acrobat Standard or Pro to compress PDF files.  The steps used to accomplish this using 
Acrobat are similar and will be covered in this section. 
 
 
COMPRESSING LARGE FILES USING ADOBE ACROBAT STANDARD 
 

1. Open Adobe Acrobat and access the PDF document that you will be compressing. 
 

2. From the View menu, choose Tools, and click on the Document Processing 
option. 
 

 
 

3. From the sidebar that opens on the right, choose Optimize Scanned PDF. 
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4. The Optimize Scanned PDF dialog box opens.  
 

5. Verify the All Pages option is selected. 
 

6. If the document is not searchable, select the Make Searchable (Apply OCR) 
option. 
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7. The default setting of the remaining options may be left as is to compress the PDF 
document. 
 

8. Click OK to begin the optimization process. It may take time, depending on the 
size of the PDF document, to optimize the file. 
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9. After optimization is complete, select Save As to save the document. Once Saved,  
compare the file size to the original to confirm the file has been compressed. 
 

 
 

10. If the PDF document has been sufficiently compressed you are ready to file 
document. 
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COMPRESSING LARGE FILES USING ADOBE ACROBAT PRO 
 

1. Open Adobe Acrobat Pro and access the PDF document that you will be 
compressing. 

2. From the Toolbar select the Tools option on the far right side of the page. 
 

 
 

3. Click on Document Processing to select the Optimize Scanned PDF option. 
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4. The Optimize Scanned PDF dialog box opens.  
 

5. Verify the All Pages option is selected. 
 

6. If the document is not searchable, select the Make Searchable (Apply OCR) 
option. 
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7. The default setting of the remaining options may be left as is to compress the PDF 

document. 
 

8. Click OK to begin the optimization process. It may take time, depending on the 
size of the PDF document, to optimize the file. 
 
 

9. After optimization is complete, select Save As to save the document. Once Saved,  
compare the file size to the original to confirm the file has been compressed. 

 
 

10. If the PDF document has been sufficiently compressed you are ready to file 
document.  
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J. HOW TO CREATE AN APPENDIX USING THE DISTRICT COURT 
DOCKET 
 
 This section will describe how to use the district court’s website to put together an 
appendix using the pleadings on the docket.  By using the district court’s “Create 
Appendix” function the system will automatically create bookmarks in the PDF to the 
documents you select from the docket report.  Please note: due to access issues, sealed 
documents may not be available when using this functionality. Any sealed pleadings to be 
included in an appendix may need to be compiled separately. 
 
 This method of compiling pleadings for inclusion in an appendix is not required; 
should counsel have a method that is more efficient for their situation (for example, 
compiling a paper appendix, then scanning it to PDF), they are encouraged to do so. 
 
 

1. Access the district court’s pacer website.  For some districts, counsel may need to 
log in to the district court’s ECF filing system to access the Create Appendix 
functionality.  If this option is unavailable, counsel will have to use other means to 
compile the electronic appendix. 
 

2. From the Reports menu select Docket Sheet. 
 

3. Type in the district court number in the Case number field. 
 

4. Under Document Options select Create Appendix. Click Run Report to proceed. 
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5. On the docket report that is generated, check the boxes next to the appropriate 

pleadings to be included in the appendix. 
 

6. On the bottom of the docket report page, select Include full docket sheet for the 
first volume of your appendix.  For subsequent volumes, select Include abridged 
docket sheet. 
 

7. Select the Include documents in Appendix option for all volumes of appendices. 
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8. The Total file size of selected documents (MB) is displayed on the bottom of the 
page.  This court has a 10 MB file size limit per attachment.  Larger file sizes will 
take much longer to upload.  As a result, you must pay close attention to the file 
size.  You may de-select documents to reduce the file size and create multiple 
volumes of appendices. 
 

9. Click Download Selected to generate the Appendix as a PDF document. 
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10. The docket sheet will be the first document of the appendix, followed by the 
pleadings.  The bookmarks for the appendix will appear on the left side.  It may be 
necessary to edit the bookmarks to correctly identify the pleadings. 
 

11.  Once any necessary changes are made, save the appendix for filing. 
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V.  ECF EVENT & RELIEF CATEGORY BREAKDOWN 
10th CIRCUIT COURT OF APPEALS 

January 2015 
 
If you are unable to locate an event/relief code for the pleading you are filing, please 
contact the clerk=s office (303/844-3157) for assistance. Items with an asterisk (*) will 
need to have a relief code entered on a subsequent screen. 
 
ECF EVENT CODES 
 
1. Attorney Discipline 

a. Attorney Discipline Response Filed 
 
2. Preliminary Appeal Documents 

a. File a Designation of Record 
b. File a Docketing Statement 
c. File a Transcript Order Acknowledgment Form 
d. File an Entry of Appearance 
e. File an Errata Sheet to a Docketing Statement 
f. File Notice of Non-Participation 
g. File Notice That Transcript is Unnecessary 
h. File Notice That Transcripts are Already on File in District Court 

 
3. Release in a Criminal Case 

a. Appellant=s Bail Memo Brief 
b. Appellee=s Bail Memo Brief 
c. Appellee/Respondent=s Notice That No Brief Will Be Filed 
d. File a Motion (*) 

 
4. Filing a Motion/Application/Response 

a. File a Motion (*) 
b. File a Proposed Judgment (App. For Enforcement only) 
c. File a Reply 
d. File a Response 
e. File a Stipulation to Dismiss (*) 
f. File an Answer (App. For Enforcement only) 

 
5. Filing a Brief and Appendix 

a. Appellant’s Appendix  
b. Appellant=s Bail Memo Brief 
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  c. Appellant=s Jurisdiction Memo Brief 
d. Appellant=s Opening Brief 
e. Appellant=s Reply Brief 
f. Appellant=s Supplemental Brief 
g. Appellee’s Appendix 
h Appellee=s Bail Memo Brief 
i. Appellee=s Jurisdiction Memo Brief 
j. Appellee=s Notice That No Brief Will Be Filed 
k. Appellee=s Response Brief 
l. Appellee=s Supplemental Brief 
m. Brief per Anders v. California 
n. Cross-Appeal 1st Brief 
o. Cross-Appeal 2nd Brief 
p. Cross-Appeal 3rd Brief 
q. Cross-Appeal 4th Brief 
r. Death Penalty Appellant=s Opening Brief 
s. Death Penalty Appellant=s Reply Brief 
t. Death Penalty Appellee=s Response Brief 
u. Errata Sheet to a Brief 
v. Corporate Disclosure Statement 
w. Joinder to a Brief 
x. Supplemental Appendix 

 
6. Suppl. Auth. Per Fed. R. App. P. 28(j) 

a. File a Reply 
b. File a Response 
c. File a Supplemental Authority- 28(j) Letter 

 
7. Amicus/Intervenor=s Motions/Briefing 

a. File a Motion (*) 
b. File a Motion to Become an Amicus Curiae (*) 
c. File a Notice of Intervention 
d. File a Reply 
e. File a Response 
f. File an Amicus Curiae Brief 
g. File Intervenor=s Brief 

 
8. Oral Argument 

a. File a Motion(*) 
b. File a Reply 
c. File a Response 
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d. File Custody Status Form 
e. File Oral Argument Acknowledgment Form 
 

9. Rehearing Petition 
a. File a Motion(*) 
b. File a Petition for Rehearing(*) 
c. File a Reply 
d. File a Response 

 
10. Bill of Costs  

a. File a Bill of Costs 
b. File a Reply 
c. File a Response 

 
11. Fee Payment for Original Proceeding 

a. Pay Fee for Petition for Review 
b. Pay Fee for Writ of Mandamus 

 
12. Other 

a. Attorney Disciplinary Response 
b. Errata Sheet to a Brief 
c. File a Certificate of Service 
d. File a Certified List in Agency Matters 
e. File a Notice of Change of Address 
f. File a Status Report 
g. File Errata Sheet to a Docketing Statement 
h. File Case Management Statement of Issues 
i. File Corporate Disclosure Statement 
j. File Notice of Automatic Bankruptcy Stay 
k. File Notice of Non-Participation  
l. Joinder to a Brief 

 
13. Sealed Briefs and Motions 

a. File a Sealed Proposed Litigation Budget 
b. File a Motion Under Seal (*) 
c. File Sealed Appellant=s Opening Brief 
d. File Sealed Appellant=s Reply Brief 
e. File Sealed Appellee=s Response Brief 
f. File Sealed Cross-Appeal 1st Brief 
g. File Sealed Cross-Appeal 2nd Brief 
h. File Sealed Cross-Appeal 3rd Brief 
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i. File Sealed Cross-Appeal 4th Brief 
j. File Sealed Docketing Statement 
k. File Sealed Response 
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ECF RELIEF CODES 
 
Note: all reliefs are accessible by selecting Aall reliefs@ from the Category drop-down 
menu. 
 
1. Abeyance 

a. abate case 
b. certify question of state law 
c. extension of time to file response 

 
2. Add/Withdraw Party-Attorney 

a. appoint attorney 
b. dismiss party  
c. extension of time to file response 
d. leave to file amicus brief 
e. leave to file intervenor brief 
f. substitute a party 
g. substitute counsel  
h. withdraw as attorney of record 

 
3. Briefing 

a. abate case 
b. application for certificate of appealability 
c. consolidate briefs 
d. defer filing of appendix 
e. exemption from electronic appendix 
f. expedite case 
g. extension of time to file 1st cross-appeal brief 
h. extension of time to file 2nd cross-appeal brief 
i. extension of time to file 3rd cross-appeal brief 
j. extension of time to file 4th cross-appeal brief 
k. extension of time to file certificate of appealability 
l. extension of time to file response 
m. extension of time to file amicus brief 
n. extension of time to file appellant=s memo brief 
o. extension of time to file appellant=s opening brief 
p. extension of time to file appellant=s reply brief 
q. extension of time to file appellee=s brief 
r. extension of time to file appellee=s memo brief 
s. extension of time to file enforcement of plea agreement 
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t. extension of time to file intervenor brief 
u. for stay 
v. leave to file brief out of time 
w. leave to file an appendix 
x. leave to file consolidated briefs 
y. leave to file corrected/substitute brief 
z. leave to file motion out of time 
aa. leave to file oversized brief 
bb. leave to file single copy of appendix and waive service 
cc. leave to file supplemental appendix 
dd. leave to file supplemental brief 
ee. leave to proceed on record on appeal 
ff. remand appeal 
gg. seal a pleading 
hh. strike a pleading 
ii. submit appeal on the briefs 
jj. supplement the record on appeal 

 kk. unseal a pleading 
ll. vacate order/argument 

 
4. Consolidation 

a. consolidate appeals 
b. consolidate briefs 

 
5. Dispositive 

a. dismiss appeal 
b. extension of time to file response 
c. extension of time to file motion to dismiss 
d. remand appeal 

 
6. Fee 

a. extension of time to file fees/1915 forms 
b. extension of time file fees/IFP forms 
c. extension of time to pay filing fee 
d. leave to proceed IFP 
e. leave to proceed pursuant to 1915 

 
7. Miscellaneous 

a. enforce plea agreement 
b. enlarge time for oral argument 
c. expedite case 
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d. extension of time to file motion to dismiss 
e. for release pending appeal 
f. for stay 
g. injunction pending appeal 

 h. leave to allow amicus to participate at oral argument 
i. leave to argue via videoconference 
j. leave to file a reply 
k. leave to file motion out of time 
l. leave to file a single copy of appendix and waive service 
m. reconsider 
n. release oral argument recording 
o. remand appeal 
p. request for attorneys fees 
q. request for preliminary injunction 
r. reschedule case management conference 
s. reschedule oral argument 
t. seal a pleading 
u. strike a pleading 
v. submit appeal on the briefs 
w. unseal a pleading 
x. vacate order/argument 
y. waive pleading/requirement 

 
8. Preliminary Materials 

a. application for certificate of appealabilty 
b. extension of time to file designation of record 
c. extension of time to file docketing statement 
d. extension of time to file enforcement of plea agreement 
e. extension of time to file fee/IFP forms 
f. extension of time to file notice of appearance 
g. extension of time to file transcript 
h. extension of time to file transcript order form 
i. extension of time to pay filing fee 
j. file designation of record out of time 
k. file docketing statement out of time 
l. for release pending appeal 
m. for stay 
n. injunction pending appeal 
o. leave to proceed IFP 
p. leave to proceed pursuant to 1915 
q. request for preliminary injunction 
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9. Record On Appeal 

a. defer filing of appendix 
b. exemption from electronic appendix 
c. extension of time to file agency record on appeal 
d. extension of time to file transcript 
e. extension of time to file transcript order form 
f. leave to file appendix 
g. leave to file single copy of appendix and waive service 
h. leave to file supplemental appendix 
i. leave to proceed on record on appeal 
j. request to borrow record on appeal 
k. supplement record on appeal 

 
10. Rehearing/Post Disposition 

a. extension of time to file response 
b. extension of time to file petition for rehearing 
c. leave to file petition for rehearing out of time 
d. petition for panel rehearing 
e. recall mandate 
f. reinstate appeal 
g. request for attorneys fees 
h. request for rehearing en banc 
i. request to publish court=s opinion 
j. stay the mandate 
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WHERE TO GET HELP 
 
A.  If you make a mistake when filing, or have questions about the Electronic Filing 
procedures or rules, please contact the clerk=s office by telephone (303-844-3157) or via 
email (10th_circuit_clerk@ca10.uscourts.gov). Clerk=s office hours are 8:00 a.m. to 5:00 
p.m. Monday- Friday MST. 
 
B.  Questions about PACER and/or technical questions or requests for technical assistance 
should be directed to PACER (telephone number 800-676-6856).  PACER Service Center 
hours are 8:00 a.m. to 6:00 p.m. Monday- Friday CST. 
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VI.  FREQUENTLY ASKED QUESTIONS 
 
If you have a CM/ECF question and cannot find the answer here, please feel free to 
contact the clerk=s office at 303-844-3157.  Please contact the PACER Service Center at 
800-676-6856 for any technical questions or requests for technical assistance. 
 
 
1.  What documents may be filed using CM/ECF?  What documents may not be 
filed? 
Counsel must file all documents with the court using CM/ECF with the exception of ex 
parte pleadings.  In addition, please note that while you may not open a new appeal via 
ECF you have the option to submit petitions for agency review, petitions for permission to 
appeal, and original writs using CM/ECF.  Notices of appeal will continue to be forwarded 
by the trial courts.  Original and agency matters may be submitted via ECF, in paper form, 
or via email to 10th_Circuit_Clerk@ca10.uscourts.gov.  
 
2.  Do I need to send the clerk a paper copy of a document filed through CM/ECF? 
No, with the exception of briefs, appendices, and petitions for rehearing en banc.  You 
must provide the court with seven hard copies of any brief filed, one hard copy of any 
appendix, and 12 hard copies of any petition for rehearing en banc filed.  The hard copies 
must be received within 2 business days of filing via ECF (please note any party who 
receives an exemption from the electronic appendix rule must submit two hard copies of 
the appendix).   
 
3.  Does my document need a certificate of service? 
Yes.  A certificate of service is required for all filings.  The certificate should be the last 
page of the document. 
 
4.  Am I required to serve a copy of my document on the other side, or does my filing 
through CM/ECF fulfill that requirement? 
You may effect service using ECF for all parties who are registered ECF participants.  
Parties and counsel should note, however, that the duty for confirming service remains 
with the party serving the pleading.  When the opposing party is not an ECF participant, 
service must be effected through traditional means.    
 
5.  The opposing party/attorney is not participating in CM/ECF.  How do I serve 
them? 
When the opposing party/attorney is not an active participant in CM/ECF, you must serve 
them in the traditional manner (generally through service of a hard copy via regular mail).  
See Federal Rule of Appellate Procedure Rule 25(c)(1); 10th Cir. R. 25.4.  You can 
determine whether a case participant can be served via CM/ECF by looking at the Notice 
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of Docket Activity sent to you, by reviewing the docket sheet in PACER, which contains 
all noticing information for parties/attorneys, or by utilizing the AService Method Report@ 
available in ECF under the AReports@ drop-down menu.   
 
6.  I am a pro se party in an appeal.  Am I required/expected to file my documents 
through CM/ECF? 
Pro se parties are not required to file documents with the court using CM/ECF.  Should a 
pro se party wish to do so, however, he/she can file a motion with the court requesting 
permission to file electronically in a specific case.  A motion is required.  An order 
granting the motion will be a prerequisite to filing via the court=s ECF system.  If an order 
granting the request issues, the pro se party may register to use CM/ECF.   
 
7.  Can I view pro se filings through CM/ECF and PACER? 
Yes.  The clerk=s office will scan all pro se filings and will attach them to the relevant 
docket entries as PDFs.  
 
8.  What is a Notice of Docket Activity? 
A Notice of Docket Activity (NDA) is a notice sent via email that is generated when a 
docket transaction requires that notice be sent to attorneys, case participants, and/or court 
personnel.  NDAs can be generated when a party or attorney files a document with the 
clerk=s office or when the court enters an order or takes other public action in a case.  If 
you are a CM/ECF participant, your receipt of the NDA is service of that document or 
order, and registration in the CM/ECF system constitutes consent to receive service 
through the NDA.  Generally, an NDA contains a hyperlink back to the court=s docket 
sheet and the document in question.  When parties receive an NDA they can click on the 
document and obtain a Afree look@ at the document.  Because there is only one free look, 
parties should be sure to save the document upon that initial review.  In the district court 
and bankruptcy court systems the NDA is called the Notice of Electronic Filing (NEF).  
 
9.  Why did I receive a second Notice of Docket Activity for my filing? 
The clerk=s office reviews all attorney filings as part of its quality control procedures.  In 
the event a case manager finds an error or needs to modify the docket text for the event 
and filing, he/she will make the necessary changes and send a new Notice of Docket 
Activity to the case participants.  If you receive a second Notice of Docket Activity and 
cannot determine the reason for the second Notice, please contact the clerk=s office. 
 
10.  Can I receive a daily summary of all my notices, or am I required to receive a 
Notice of Docket Activity for every action or activity in my case(s)? 
PACER gives you the option of receiving a daily summary or individual event noticing.  
The default is individual event noticing, but you can change that by updating your account 
information at the Pacer Service Center under AFiler Account Update.@  If you prefer a 
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daily summary, select ADaily Summary@ instead of AEach Transaction@ on the ANotice of 
Docket Activity Frequency@ option. 
 
11. I am not shown as an attorney in the case, but I want to file on behalf of one of 
the parties in the appeal.  How do I do that? 
The clerk=s office relies on the notice of appeal and district court docket sheet when 
opening a new appeal and setting up the party and attorney information.  In some 
instances that information is not complete or may change after the appeal is opened, and 
you may need to be added as an attorney in the case.  Until you are added as an attorney in 
the case, you will not receive NDAs from the court nor will you be able to file any 
documents other than an entry of appearance.  Once you have filed an entry of appearance 
in the appeal and the court has reviewed that pleading, you will be eligible to receive 
NDAs and to file further documents in the appeal.  Remember, you must register with the 
PACER service center as an appellate filer and receive a CM/ECF login/password before 
you can use CM/ECF (please note appellate registration is distinct and is required even if 
you have registered for the district court proceedings). In addition, please note that 
because court review of entries of appearance is required, you will not be able to file as a 
new attorney until that review is completed.   
 
12.  I want to enter my appearance in an appeal.  How do I do that? 
You must be an authorized appellate CM/ECF user with a valid Tenth Circuit CM/ECF 
login and password in order to file an entry of appearance or any other pleading.  
Authorized users may complete the entry of appearance form found in the AForms@ section 
of the court=s website.  Save the form to your computer, complete it, and attach it in PDF 
format to the ANotice of Appearance Filed@ docketing event/option in the court=s CM/ECF 
system.  Information on how to docket pleadings is available via the >Help= drop-down 
menu accessible in the top menu bar, as well as in the court=s ACM/ECF User=s Manual.@ 
 
13.  I want to file a document under seal.  How do I do that? 
After logging into CM/ECF and entering your appeal number, you must select the ASealed 
Briefs and Motions@ category.  These events were specifically designed to seal all 
pleadings filed in this category.  You may file a sealed motion, response, or brief in this 
manner.  Failure to select the ASealed Briefs and Motions@ category will result in your 
pleading being filed as a public document.  Please contact the clerk=s office if you have 
any questions. 
 
14.  I made a mistake, such as filing in the wrong case or submitting an incorrect 
document.  What should I do? 
You cannot delete events or documents, nor can you make changes to completed 
docketing events.  If you have made an error, contact the clerk=s office.  Our office will 
delete the document and modify the docket text to reflect what has been done.  You may 
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then re-file the document using the regular CM/ECF filing procedures.  Parties and 
counsel should be aware the court will not automatically extend the deadline for filing in 
the event of user error.   
 
15.  I am unable to view a pleading in a Social Security case or in an immigration 
petition for review.  Is there a problem? 
There is no problem.  Electronic access to pleadings filed in Social Security and 
immigration cases is restricted to the attorneys or parties in the case in order to protect the 
privacy of the individuals involved.  You may review materials from these cases in person 
in the clerk=s office.  If you are a party or attorney in the case, please note that you can 
access documents in these proceedings only through the use of your CM/ECF filer ID and 
password.  You will not be able to access them through your PACER ID and password 
(that is, the PACER viewing account).  Please see the court=s CM/ECF User=s Manual at 
page 13 for additional information on using the CM/ECF filer ID and password.   
 
16.  I represent a party that wants to be added to an appeal, such as an amicus.  How 
do I do that? 
After logging into CM/ECF and entering your appeal number, you must select the 
AAmicus/Intervenor=s Motions/Briefing@ category.  You must either select the AMotion to 
Become an Amicus Curiae@ or AFile an Amicus Curiae Brief.@  If you are moving to 
intervene in an appeal, you must choose AFile a Notice of Intervention.@  You must enter 
the name of the party(s) filing the pleading when you are docketing the selected event.  
 
17.  What help is available for CM/ECF? 
The court has created a User Manual to aid attorneys using ECF.  The manual is available 
on the court=s website at www.ca10.uscourts.gov.  In addition, we have created training 
modules which are available in both interactive and printable form.  Those modules can 
also be found on the court=s website under the ACourt Docket and E-filing@ tab.  We 
strongly encourage counsel to review all available training modules before filing in the 
ECF system.    
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You may also contact the clerk=s office for assistance with filing.  If you are having 
difficulty registering for CM/ECF or have questions about your PACER or CM/ECF 
accounts, you should contact the PACER Service Center at 800-676-6856.  If you need to 
modify or update either your PACER or CM/ECF accounts, you may do so at the PACER 
website: https://pacer.gov 
The PACER Service Center maintains extensive lists of FAQs for both PACER and 
CM/ECF.  You may access them at the PACER website. 
 
18.  When is CM/ECF available? 
The system is always available (except for routine or emergency maintenance), and you 
should be able to file anytime.  Notices regarding down times for CM/ECF will be posted 
on our website.  Filings completed before midnight Mountain Standard Time will be 
docketed as of that day.  Please note filings received on Saturday, Sunday or a federal 
holiday will be considered filed on the next business day. 
 
19.  I am able to log in to CM/ECF, but I cannot see anything.  What=s going on? 
Most likely, you simply need to update the version of JAVA that you have on your PC.  
Go to www.java.com and download the latest version of JAVA (it is a free download).  
Restart your PC and try again.  We have found that 90% of the problems experienced with 
CM/ECF can be attributed to not having the proper version of JAVA loaded. 
 
In addition, we have found CM/ECF issues are often attributed to the need for a more 
current version of the web browser.  CM/ECF has been certified to work with Mozilla 
Firefox, Internet Explorer versions 8.x/9.x or higher, and Safari. 
 
20.  I need to file something but I cannot log in.  What=s going on? 
Make sure that you are actually registered to use ECF for the 10th Circuit.  Some people 
mistakenly believe that if they are registered for another circuit, they are automatically 
able to file in any circuit.  ECF users must register for each circuit separately.  Similarly, if 
you have an ECF login/password for a district court, you will also need to register to file 
in this circuit.  Your district court log in will not allow you to do so.   
 
Also, having a PACER login/password (i.e., a Aviewing account@) does not mean you are 
automatically registered for ECF.  PACER and ECF are two separate entities, and separate 
registration is required for each.  If you have forgotten your username and/or password, 
you must contact PACER.  The court does not have access to that information. 
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UNITED STATES COURT OF APPEALS 
 

FOR THE TENTH CIRCUIT 
 
 

 
In re: 
 
Electronic Submission of Documents and 
Conversion to Electronic Case Filing 
 
 

 
 

No. 95-01 

 
 

GENERAL ORDER 

 
 
Before HENRY, Chief Judge, TACHA, KELLY, BRISCOE, LUCERO, MURPHY, 
HARTZ, O’BRIEN, MCCONNELL, TYMKOVICH, GORSUCH, and HOLMES, 
Circuit Judges. 
  
 

Introduction 
 

 On September 4, 2007, the court converted to a new electronic case management 

system.  That conversion did not include, however, Electronic Case Filing (ECF) for 

counsel and litigants.  Since that time, we have required counsel to submit materials via 

email for placement on the docket.  On March 31, 2009, the United States Court of 

Appeals for the Tenth Circuit will transition to voluntary ECF.  On June 1, 2009, ECF will 

become mandatory for counsel of record.  This order outlines the broad requirements for 

filing in the new system.  The court’s CM/ECF Users Manual, which can be found at 

www.ca10.uscourts.gov, sets forth specific policies and procedures related to filing in the 
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new system.   

I.  General Requirements 

 It is essential that counsel seeking to file via ECF review carefully the technical and 

training information on the court’s website.  In addition to the required registration on 

Pacer, counsel must also confirm that certain technical requirements of the system are 

met.  These requirements include, but are not limited to, obtaining the proper version of 

Java and Adobe software.   

 In addition, we urge all counsel to review the court’s training materials, which 

include the comprehensive CM/ECF Users Manual and various software modules.  These 

tools, which can be found on the court’s website, provide a step-by-step guide to ECF.  

We have also provided a set of Frequently Asked Questions.  As ECF registration and 

review of the training materials take time, we urge all counsel to prepare well in advance 

of the need to file pleadings.   

 Finally, counsel must review the file size of all submissions before proceeding in 

ECF.  Documents filed with the court electronically are limited to 10 megabytes per 

uploaded file.  More than one file may be uploaded to a particular entry (for attachments 

and the like) provided that the total file size for that entry does not exceed 50 megabytes.  

II.  Pleadings Filed 
 

 A.  Briefs 
 
 Counsel filing via ECF may submit all briefs using the new system.  In addition, 

however, within 2 business days of the filing, counsel must also submit to the clerk’s 
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office 7 hard copies of the brief.  Briefs may contain, but are not required to contain, 

hyperlinks to cases and authorities.  The brief itself must be filed in native pdf format.   

 Unless file size limitations are implicated, attachment(s) to briefs available in 

native pdf format must be included with the brief in the same pdf (that is, if the 

attachments required under 10th Cir. R. 28.2 are in native pdf they must be included with 

the brief in a single document and can be filed via ECF).  Required attachments not 

available in native pdf may be submitted in scanned pdf format.  If some of the required 

attachments are available in native pdf and some are not, all of the attachments may be 

scanned and attached separately to the entry.  The ECF system allows counsel to attach 

additional files to the “brief filed” event.   

 In this regard, we note file size restrictions may require counsel to add attachments.  

Counsel should reference the Users Manual for instructions on how to submit attachments 

which are included in separate pdf files.  As noted above, counsel must always ensure the 

documents meet the court’s file size limitations.   

 B.  Appendices and Addenda 

 Unlike all other pleadings, appendices and addenda must be submitted to the court 

in hard copy only.  Specifically, this exception includes appendices and addenda filed per 

Federal Rules of Appellate Procedure 10 and 30 and 10th Circuit Rules 9.2(B), 10 and 30.  

These materials cannot be submitted via ECF at this time.  Filers must submit two hard 

copies of these materials to the clerk’s office.  Where the appendix or addendum is due 

simultaneously with a motion or brief the hard copies must be received in the clerk’s office 



 
 98 

within 2 business days of the ECF filing.   

 C.  Other pleadings 

 All pleadings, with the exceptions noted in Section II B of this order, must be 

submitted via ECF (with the caveat that ECF is voluntary until June 1, 2009, at which time 

it will become mandatory).  Included are preliminary pleadings and materials, motions, 

notices, petitions for rehearing, cost bills and submissions per Federal Rule of Appellate 

Procedure 28(j).  As noted above, the only materials exempt from ECF are appendices and 

addenda.  All ECF pleadings must be filed in native pdf and must meet the size 

requirements of the system outlined in the General Requirements section of this order.   

 ECF users need not submit any additional hard copies of pleadings filed through 

the electronic system with two exceptions.  Those exceptions include briefs, as outlined in 

Section II A, and petitions for rehearing en banc.  Specifically, within 2 business days of 

the ECF filing counsel or litigants must submit 7 hard copies of any brief filed (including 

jurisdictional and memoranda briefs).  Likewise, within 2 business days of filing a petition 

for rehearing en banc (please note, this requirement does not include petitions for panel 

rehearing) the ECF filer must submit 18 copies of the en banc request.  See 10th Cir. R. 

35.4.   

 As is the case with briefs, any attachments to motions or other pleadings not 

available in native pdf may be scanned and submitted as separate attachments to the ECF 

entry.  The court prefers, however, that attachments be submitted in native pdf if possible.  

All attachments must adhere to the file size restrictions outlined in the General 
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Requirements section of this order.    

 D.  Sealed Materials 

 The ECF system includes events specifically intended for use in submitting sealed 

materials.  Counsel and litigants may file a sealed motion, response or brief.  Any failure 

to select the “Sealed Briefs and Motions” category in ECF will result in a public, rather 

than private, submission.  Counsel and litigants are responsible for ensuring that sealed 

materials are filed using these events.  Parties seeking to submit a motion to seal materials 

simultaneously with the materials should use these events even if the motion is not 

submitted as sealed.   

 E.  Case Openings Including Original Proceedings 

 Parties will not be allowed to initiate appeals or original proceedings in ECF.  The 

clerk’s office will open all appeals upon receipt of materials from the district courts, and 

will notify the parties via a Notice of Docket Activity.  Likewise, the clerk’s office will 

open all agency matters and original petitions and will then notify the parties.  Once ECF 

is mandatory on June 1, 2009, case initiating materials for original proceedings and 

agency matters must be submitted to the court in hard copy form or via email to 

10th_Circuit_clerk@ca10.uscourts.gov  Until that date, parties may submit these materials 

in hard copy or via email to esubmission@ca10.uscourts.gov. 

 

III.  Pro Se Filers 

 All pro se litigants may continue to file documents in paper form.  In a given case, 

mailto:Ca10_Clerk@ca10.uscourts.gov.
mailto:esubmission@ca10.uscourts.gov.
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however, a pro se party who is a named appellant, petitioner, respondent or appellee may 

seek permission to file using ECF.  Specifically, pro se litigants seeking permission to 

submit documents via ECF should file a motion for permission in hard copy form at the 

earliest opportunity.  The motion should be filed in the proceeding in which the party 

seeks to file.  If approved, the pro se filer will be authorized to submit documents via ECF  

in that matter only.   

IV.  Privacy Protection and Redactions 

 All filers are required to follow the privacy and redaction requirements of Fed. R. 

App. P. 25(a)(5), as well as applicable federal rules of civil procedure, criminal procedure 

and the relevant bankruptcy rule.  See Fed. R. Civ. P. 5.2; Fed. R. Crim. P. 49.1; Fed. R. 

Bankr. P. 9037.  Required redactions include social security numbers and taxpayer 

identification numbers (filers may disclose the last four digits of a social security or tax 

identification number), birth dates (use year of birth only), minors’ names (initials may be 

used), and financial account numbers (except those identifying property allegedly subject 

to forfeiture in a forfeiture proceeding).  It is the sole responsibility of the filer to redact 

pleadings appropriately.   

V.  Digital Signatures and Certification 

 A.  Digital Signature 

 All ECF submissions requiring a signature shall be signed in the following  
 manner: 
 

s/ Attorney (or where applicable, pro se party) 
Street Address 
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Telephone Number 
Email Address 

 

 B.  Certification 

In addition to a certificate of service, all ECF pleadings shall include certification 
that: 

 
 (1) all required privacy redactions have been made; 

 (2) if required to file additional hard copies, that the ECF submission is an exact  
 copy of those documents; 
 

(3) the ECF submission was scanned for viruses with the most recent version of a 

commercial virus scanning program (naming the program, version, and the 

date of the most recent update), and, according to the program is free of 

viruses.    

 C.  Service Requirements 

 Effective June 1, 2009 when ECF becomes mandatory for all counsel of record, the 

Notice of Docket Activity generated by the Court’s ECF system will constitute effective 

service of the filed document on system participants.  Pleadings must, however, still 

include a certificate of service stating that service was effected via the ECF system.  Pro 

se parties who are not registered to be served through the system must receive service in 

some other appropriate manner.  For information regarding how to determine who is a 

system participant, please refer to the court’s CM/ECF Users Manual.   

 Prior to June 1 2009, when ECF is voluntary, parties electing to use ECF may use 

Notices of Docket Activity for service provided they comply with the general service rules 
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(i.e., that a certificate of service is included in the pleading and that filers confirm 

everyone in the case is served in the manner they wish–ECF for those who are registered 

but email or hard copy for those who are not).  Counsel and parties should consult the 

court’s CM/ECF User’s Manual for additional information on service requirements.   

 

 
       Entered for the Court, 
 
 
 
 
       ELISABETH A. SHUMAKER 
       Clerk of Court 
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VIII. HOW TO SUBMIT AN ORIGINAL PROCEEDING WITH FEE 
PAYMENT 
 
The court’s Electronic Case Filing (ECF) application may be used to submit your 
agency petition for review, or writ of mandamus, along with a fee payment using 
Pay.gov.  You must be a registered ECF user with this court to submit the 
petition and/or payment. 
Before you start, please turn off any pop-up blockers that would prevent you from 
seeing the payment processing page.  The payment window from Pay.gov opens in 
a new browser window or browser tab.  In addition, make sure you have your 
agency petition or mandamus and any supporting documents ready to upload.  All 
documents must be in searchable PDF format and each PDF must not exceed 10 
MB in size. 
NOTE:  If you seek emergency relief you must also contact the clerk’s office 
via phone at 303-335-3157 during regular business hours. 
 

1. On the start-up page after logging into ECF, select Utilities to see the 
submission options.  Select Open New Agency Review Proceeding or Open 
New Mandamus Proceeding.   

2. After making your selection, you have the option to select either submit the 
petition and Pay Agency/Mandamus Fee by Credit Card or submit the 
petition and Address Agency/Mandamus Fee Later.   

3. In this example, we will use Pay Agency Fee by Credit Card to submit a 
payment with an agency petition for review (note: the steps for filing a 
petition for a writ of mandamus are essentially identical to what is outlined 
here ). 

4. The Pay Agency Fee by Credit Card window will open in a new window and 
look similar to the image below.  Please read the directions on the screen 
carefully before proceeding with your petition submission and payment.  
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5. After carefully reading the on-screen directions, click the Browse button to 

select your PDF attachments. 
a. Search for the PDF file that contains your agency petition. 
b. Select the appropriate file and click the Open button. 

6. In the Description field for the document, type the word “Petition for 
Review” as the description of the PDF. 

7. Click Add Another Document and repeat steps 5 and 6 if you need to attach 
further documentation or attachments.  Please remember to include a 
description for any additional attachments. 
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8. After attaching your documentation, click the Pay Now and Submit button to 
begin the submission of the credit card payment.  You will now be connected 
to Pay.gov.  A new browser window or browser tab will open allowing you to 
enter and submit your credit card information.   
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9. Verify and change the information in the Account Holder Name field and the 

billing address fields as needed. 
CAUTION: The name and address shown here are the name and address 
associated with your appellate ECF account.  If you are using a credit card 
that is not associated with this address, you must update the billing address 
fields. 

10.  Complete the Card Type, Card Numbers, Security Code and Expiration Date 
fields. 

11. In the Attorney Name field, type the name of the attorney who is submitting 
the petition and payment. 

12. Complete the Contact Telephone Number and Person Completing 
Transaction fields so that the court may contact you if there are any issues 
with the payment. 
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13. Click the Continue with Plastic Card Payment button. 

 
 

14. On the Authorize Payment page, review all the payment information for 
accuracy.  You may click the Edit this Information link to make any 
necessary changes. 

15. Complete the Email Address, Confirm Email Address and CC fields.  
Completing these fields will allow you to receive a payment confirmation 
email after the payment has been processed. 

16. Select the checkbox under Authorization and Disclosure. 
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17. Click the Submit Payment button only once.  You MUST wait for Pay.gov to 
process your payment.  Do not click the button again. 

18.  The following screen will appear indicating your payment has been 
accepted.  You may print this screen as a receipt.  A copy will be emailed to 
the email addresses you provided on the previous screen. 
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19. Click on the Close Window button to return to the ECF application. 
20. You may find you have returned to a black screen.  If this happens, click on 

the ECF application icon in your tool bar and you will return to ECF.  
21. You may now continue with other ECF activity or simply log out of ECF.  
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The court’s Electronic Case Filing (ECF) application may be used to submit an 
agency petition for review or petition for writ of mandamus/prohibition without 
paying the filing fee immediately.  You must be a registered ECF user with this 
court to submit the petition. 
Make sure you have your agency petition or mandamus petition and any supporting 
documents ready to upload.  All documents must be in searchable PDF format and 
each PDF must not exceed 10 MB in size.   
The following sections outline how to electronically file a petition with the court 
without submitting immediate payment, and how to electronically submit payment 
for an existing petition. 
 
NOTE:  If you seek emergency relief you must also contact the clerk’s office 
via phone at 303-335-3157 during regular business hours. 
 
HOW TO FILE A PETITION WITH THE COURT WITHOUT 
SUBMITTING IMMEDIATE PAYMENT 

1. On the start-up page after logging into ECF, select Utilities to see the 
submission options.  Select Open New Agency Review Proceeding or Open 
New Mandamus Proceeding.   

2. After making your selection, you have the option to select either submit the 
petition and Pay Agency/Mandamus Fee by Credit Card or submit the 
petition and Address Agency/Mandamus Fee Later.   

3. In this example, we will use the Address Agency Fee Later option to submit 
an agency petition for review without immediately paying the filing fee 
(note: the steps for filing a petition for a writ of mandamus without 
immediately paying the filing fee are essentially identical to what is outlined 
here ). 

4. The Address Agency Fee Later window will open in a new window and look 
similar to the image below.  Please read the directions on the screen carefully 
before proceeding with your petition submission.  
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5. After carefully reading the on-screen directions, click the Browse button to 

select your PDF attachments. 
a. Search for the PDF file that contains your agency petition. 
b. Select the appropriate file and click the Open button. 

6. In the Description field for the document, type the word “Petition for 
Review” as the description of the PDF. 

7. Click Add Another Document and repeat steps 5 and 6 above if you need to 
attach further documentation or attachments.  Please remember to include a 
specific description for any additional attachments. 
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8. After attaching your documentation, click the Submit button to complete the 
submission of your petition.  The court will notify all parties once a docket 
number has been assigned. 
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HOW TO SUBMIT PAYMENT FOR AN EXISTING PETITION 
 

1. After submission of a petition, you may pay the filing fee by using a docket 
event via the court’s ECF system.  This example will show how to pay the 
filing fee for an agency petition (Note: the steps for docketing the payment 
for a writ of mandamus are essentially identical to what is outlined here).  
Before starting, you must turn off any pop-up blockers that would 
prevent you from seeing the payment processing page. 

2. Log into ECF and select Filing, followed by clicking on File a Document. 
3. Enter your case number and click on Fee Payment for Original Proceedings. 
4. Select Fee Payment for Original Proceedings to see the payment options for 

agency petitions and writs of mandamus.  As shown in the example below, 
you will only see two payment options. 
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5. In this example, select Pay Fee for Petition for Review. 
6. The docketing screen pictured below will appear indicating the amount of the 

fee to be paid.  Please read the on-screen instructions carefully before 
proceeding to pay the fee.  
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7. Click Pay Now to be re-directed to Pay.gov.  A new browser window or 
browser tab will open allowing you to enter and submit your credit card 
information. 
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8. Verify and change the information in the Account Holder Name field and the 

billing address fields as needed. 
 
CAUTION: The name and address shown here are the name and address 
associated with your appellate ECF account.  If you are using a credit card 
that is not associated with this address, you must update the billing address 
fields. 
 

9.  Complete the Card Type, Card Numbers, Security Code and Expiration Date 
fields. 

10.   In the Attorney Name field, type the name of the attorney who is submitting   
the petition and payment. 
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11.   Complete the Contact Telephone Number and Person Completing 
Transaction fields so that the court may contact you if there are any issues 
with the payment. 

12.   Click the Continue with Plastic Card Payment button. 

 
 

13.  On the Authorize Payment page, review all the payment information for 
accuracy.  You may click the Edit this Information link to make any 
necessary changes. 

14.  Complete the Email Address, Confirm Email Address and CC fields.  
Completing these fields will allow you to receive a payment confirmation 
email after the payment has been processed. 

15.  Select the checkbox under Authorization and Disclosure. 
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16.  Click the Submit Payment button only once.  You MUST wait for Pay.gov 
to process your payment.  Do not click the button again. 

17.   The following screen will appear indicating your payment has been 
accepted.  You may print this screen as a receipt.  A copy will be emailed to 
the email addresses you provided on the previous screen. 
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18.  Click on the Return to CM/ECF button to return to the ECF application. 

CAUTION: You must click the Return to CM/ECF button.  After returning to 
the ECF application you MUST click on Continue to complete the docketing 
of the fee payment.  Failure to return and click Continue will cancel the 
docketing event, but your credit card will still be charged for the payment. 
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19.  After clicking the Return to CM/ECF button, you may find you have 
returned to a black screen.  If this happens, click on the ECF application icon 
in your tool bar and you will return to ECF.  

20.  On the fee payment docketing screen you will see the Pay Now button 
has been deactivated.  You MUST click Continue to complete the 
docketing of the filing fee.  Failure to return to this screen and click 
Continue will cancel the docketing event, but your credit card will still 
be charged for the filing fee payment. 

21.  After clicking Continue, you may now continue with other ECF activity or 
simply log out of ECF.  Notice that the fee has been paid will appear on the 
court docket. 
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IX. HOW TO REQUEST A CERTIFICATE OF GOOD STANDING VIA 
ECF 
 
The court’s Electronic Case Filing application (ECF) may be used to request a 
certificate of good standing and pay the required fee.  You must be a registered 
ECF user with this court in order to request a certificate in this manner. 
Before you start, please turn off any pop-up blockers that would prevent you 
from seeing the payment page.  The payment window from Pay.gov opens in a 
new browser window or browser tab.  In addition, make sure you have your letter 
requesting a certificate of good standing and any supporting documents ready to 
upload.  All documents must be in searchable PDF format and each PDF you attach 
must not exceed 10 MB in size. 

1. On the startup page after logging into ECF, select Utilities followed by 
Request Certificate of Good Standing. 

2. The Request Certificate of Good Standing window will open in a new 
window and look similar to the image below.  Please read the directions 
carefully before proceeding with your request. 
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3. The document you attach should include the attorney’s name, date of 

admission to the bar of this court, and current address for use in mailing the 
certificate. 

4. Click the Browse button. 
a. Search for the PDF file that contains your certificate of good standing 

request. 
b. Select the appropriate file and click the Open button. 

5. In the Description field for the document, type “Request for Certificate” as 
the description of the PDF. 

6. Click Add Another Document and repeat steps 5 and 6 above if you need to 
attach further documentation.  Please include a description for additional 
attachments. 
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7. After attaching your documentation, click the Pay Now and Submit button to 
begin the submission of payment.  A new browser window or browser tab 
opens so that you can enter and submit your credit card information.  You 
will now be connected to Pay.gov. 
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8. Verify and change the information in the Account Holder Name field and the 

billing address fields as needed. 
 
CAUTION: The name and address shown here are the name and address 
associated with your appellate ECF account.  If you are using a credit card 
that is not associated with this address, you must update the billing address 
fields. 
 

9. Complete the Card Type, Card Numbers, Security Code and Expiration Date 
fields. 

10.  In the Attorney Name field, type the name of the attorney who is applying 
for bar admission. 
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11.  Complete the Contact Telephone Number and Person Completing 
Transaction fields so that the court may contact you if there are any issues 
with the payment. 

12.  Click the Continue with Plastic Card Payment button. 

 
 

13.  On the Authorize Payment page, review all the payment information for 
accuracy.  You may click the Edit this Information link to make any 
necessary changes. 

14.  Complete the Email Address, Confirm Email Address and CC fields.  
Completing these fields will allow you to receive a payment confirmation 
email after the payment has been processed. 

15.  Select the checkbox under Authorization and Disclosure. 
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16.  Click the Submit Payment button only once.  You MUST wait for Pay.gov 
to process your payment.  Do not click the button again. 

17.  The following screen will appear indicating your payment has been 
accepted.  You may print this screen as a receipt.  A copy will be emailed to 
the email addresses you provided on the previous screen. 
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18.  Click on the Close Window button to return to the ECF application. 
19.  You may find you have returned to a black screen.  If this happens, click on 

the ECF application icon in your tool bar and you will return to ECF.  
20.  You may now continue with additional ECF activity or simply log out of 

ECF.  
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